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Preface 

In the beginning, it was ‘Tiny ERP’ then changed to ‘Open ERP’ and now it is ‘Odoo’, the change 

in name has affected Odoo in many ways, especially created a confusion among users. But 

every time the team has managed to rectify the issue and they were successful in it. In the new 

makeover, the ERP has undergone many defining changes and ‘Odoo’ is a brand new 

professional ERP software now. Even though there are many dedicated documents on the 

internet about Odoo and its functionalities, we found that a comprehensive material covering 

almost all important aspects of a ‘brand new ERP’ software is not anywhere. In other words, 

there is no one-stop reference covering the questions like, why an ERP, Why Open source, ERP, 

and present business environment, Why Odoo and what are its functionalities etc.  

In the recent pasts, Odoo has been witnessing high customer demand from all over the world. 

As more users from different platforms coming into this system, service partners and 

community portals are also witnessing floods of queries about Odoo usage. When we analyze 

such queries in a broad sense, we can understand that the underlying problem is lack of a 

comprehensive guide. The bits of information scattered over internet is not much helpful to all 

users’, especially new Odoo customers. But the interesting thing is that Odoo is one of the 

simplest ERP solutions and it can be easily managed by any type of user.  

In this book, we tried to cover all such topics a user must read in current context. This book is 

neither a typical user manual nor an installation and operation guide, rather a comprehensive 

guide which will give a user an overall outlook about Odoo ERP. After going through this book 

you will get an understanding of main features and functionalities of Odoo, and of course, it 

will give you a step by step guide to configure and use Odoo. All major modules of Odoo ERP, 

its workflow, main features of the modules etc. are included in the book for a better customer 

understanding. Each section of the book is prepared considering the ultimate business user in 

mind. 

As an experienced service partner and community supporter, Cybrosys has made an 

appreciable contribution to Odoo. Our developers and resource persons are actively helping 

different types of users every day. The insight and confidence we got from such experiences 

prompted us to come with a work like this. And we have deployed our best hands to do the 

job. We believe this is an essential guide for any customer irrespective of their familiarity with 

the System. We look forward to the feedback from users, so we can improve and add more 

useful information to this document in upcoming versions. 
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ERP in New Business Era 

The word ERP (Enterprise Resource Planning) and ERP software are not new to the business 

world. Since the advent of computer itself, different types of business management software was 

available. It was in late 90’s, more advanced, integrated and efficient business management 

solutions emerged in the market called ERP solutions. In simple words, ERP refers to the systems 

and software packages used by organizations to manage their day-to-day business activities, like 

accounting, manufacturing, Sales, Purchase, Customers, and Inventory etc.  

Though initially ERP usage was confined within large enterprises, today it is an inevitable factor 

in any business organization. Yearly, more and more business organizations are attaching ERP 

solutions to manage resources more effectively and they are reaping its fruit. The Classical 

module like Accounting, Inventory, and Manufacturing, was the primary component in earlier 

ERP solutions. However, the landscape is entirely different today and changing constantly. Today, 

an efficient ERP solution incorporate functionalities like E-Commerce, M-commerce, Data 

Analysis, Decision making, Cloud storage and Management, Remote Controlling etc. In other 

words, today's ERP is more like an intelligent decision taking system rather than a decision 

support system as it were. Integrated modules and cutting-edge analysis tools combined with 

huge possibilities of internet impart such enormous capabilities to an ERP system. 

So, what are the advantages of having an efficient ERP software in your organization? It would 

be worth analyzing it in today’s business environment. 

• Increased productivity.

• Efficient management

• Integrated information

• Better analysis, Forecasting and Reporting

• Improved Security

• Mobile accessibility (Access and control your system from anywhere)

• Accurate Decision-making

• Scalability (customization meeting your changing needs)

 This list will go further if we tried to analyze each point in depth.

It is obvious from the listed points that an efficient ERP will enhance competence and 

productivity of any organization. So it is important to know different types of ERP solutions 

available in the market. There are many ERP solutions available in the market and they can be 

grouped into following categories for better understanding. 
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Proprietary ERP 

In simple words, proprietary ERP software means, an ERP solution developed, delivered and 

supported by a private company. Oracle, SAP, Microsoft Dynamics etc. are some examples of 

such software.  

Open source ERP 

Open source ERP is a system whose source code is made publicly available. The open source 

model allows companies to access the ERP system's code and customize it using their own IT 

department instead of paying extra for vendor customization services and licensing, as is typically 

the case with closed source programs[1]. Generally software in this category is free. 

Odoo, ERP Next, Dolibarr etc. are some examples of Open source ERP software. 

Cloud based  

Traditionally, ERP and other business productivity software is located on premises, meaning your 

company is responsible for purchasing, housing, and maintaining the software and all related 

hardware. But Cloud ERP is a software that is accessed in “the Cloud” – using the Internet to 

access servers that are hosted remotely from your business. Nowadays more and more ERP 

providers (both open source and proprietary) are offering this facility to their customers. 

Open source and Proprietary ERP- An analysis. 

There are many Open source and Proprietary ERP solutions available in the market. Having a 

better understanding of these two types of software is good as far as your business needs are 

concerned.  

Coast 

Generally, Proprietary ERP solutions are costlier than Open source solutions.  Hence it is 

affordable to organization irrespective of their size. 

Dependency 

With proprietary ERP solutions, you are dependent on the service provider for all help. 

Whereas in Open source you are not locked with it. 

Features 

Today, both Open source and proprietary ERP solutions are able to provide almost all 

advanced features 
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Customization 

Compared proprietary ERP, Open source is more customizable to individual business need.  

Support 

Unlike in the Past, active community support and availability of more service partner are 

keeping open source solution on par with proprietary services. 

Upgrades 

Upgrades and new features make an ERP competent in business environment. Both 

proprietary and open source solutions provide updates but we must admit that, the 

frequent developments in open source systems are far better than others. 
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Open Source ERP 

 

What is Open source?  

Open source, as the name indicate it is an open platform in the field of software technology. 

According to a widely accepted definition, open source software means a computer software 

with its source code made available with a license in which the copyright holder provides the 

rights to study, change, and distribute the software to anyone and for any purpose [2]. 

In historical perspective, open source software’s genetics dates back to 70’s when elementary 

software’s were developed. Initially, all software products were open source in fact. 

Programmers shared and co-developed source codes and developers benefited from each other 

by it. But late with the commercialization of software products like any other commodity, 

software and its source code became less shared and protected by IPR. In the beginning, 

commercialization put a setback to open source movement, but with the advent of internet the 

movement again got momentum and advanced even faster.  Today, open source software 

displays stiff competition to proprietary products with its leading presence and uncompromised 

performance in all arena of software solutions. 

Open Source ERP 

Fully fledged business management software and ERP solutions were available on the market by 

late nineties itself. But most of them were in proprietary category. Fully fledged Open source ERP 

solution came into the market by 2002 and consequent years. Initially, such software were not 

much popular as the major proprietary players lead the industry.  But later, increased online 

community support and inherent strength of open source technology pushed the industry 

forward. More and more customers attracted towards open source platform as it provided more 

ROI.  Especially, SME sector attracted more towards this affordable service providers. 

According to market research, proprietary ERP solutions still leads the market in monetary terms 

[4], yet Open source customer base is steadily increasing. It is obvious from the facts that, despite 

higher market share in monetary terms, proprietary software are facing stiff competition from 

more affordable open source solutions. Today, you can find all the features a proprietary ERP 

provides is there in open source ERP also. In fact, open source community is constantly 

incorporating more outstanding features to open ERPs.  

Different ERP’s have different set of features in their bag. Following are some essential features 

an ERP must have in today’s business environment and you can find these features in almost all 

modern open ERP software. 
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•    E-commerce module 

•    Cutting-edge analytical tools 

•    Remote control 

•    Cloud support 

•    Social media integration 

•    Easy customization 

•    Support and Upgrades 

 

How open source ERP works? 

Unlike any other software, the real challenge in ERP is ensuring further support and timely 

upgrades for your ERP suite. This is where most of the customers are forced to choose a private 

player rather than an open source solution. But in today’s context, open source ERP solutions 

rectify such problems with the help of active online community as well as paid service partners. 

Moreover, different versions of ERP (like Enterprise and Community in case of Odoo) make it 

easier for customers to ensure their future support more wisely. Cloud-based ERP software 

services are also making now things easier for open source ERP. 

Trending open source ERP’s in market basically provides following implementation options for 

their customers.   

 Company direct implementation, and services. 

In this case, the developer company directly gives ERP implementation and future support to 

customers. Usually, cloud-based ERP is provided and they will charge for it accordingly. 

 Service partners 

All open source ERP companies have authorized service partners across the globe. They provide 

all the assistance needed for a customer on a variable cost. 

 Free version. 

You can download and configure ERP your own. No fees and extra cost. But you can seek help 

from the online community for any assistance. 

Apart from this, a lot of other options are also available depends on the software provider. 

Customers can choose an implementation plan according to their convenience.  
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Open Source ERP examples 

Odoo 

Odoo is an all-in-one management software that offers a range of business applications that form 

a complete suite of enterprise management applications targeting companies of all sizes. Odoo 

is an all-in-one business software including CRM, Website/e-Commerce, billing, accounting, 

manufacturing, warehouse- and project management, and inventory. [3] 

Openbravo 

Openbravo is a retail-focused ERP based on a modular system. The software comes in three 

types. Openbravo Community edition which is free release and paid Enterprise and Professional 

editions. [3] 

ERPNext 

ERPNext is an open source solution designed for small and medium businesses (SMBs). The 

software is a collection of apps and plugins. [3] 

iDempiere 

iDempiere is a full-fledged ERP, with everything from invoicing to POS integration to warehouse 

management to forecasting. While iDempiere is open source, installing an ERP is never truly free. 

[3] 

xTuple PostBooks 

xTuple makes a range of ERP and manufacturing-focused products, but the core of all these 

options is PostBooks. PostBooks manages the central functionality of an ERP, which is extended 

by xTuple’s other offerings. [3] 
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Odoo as an ERP solution 

‘Expand as you Grow’ the tagline from Odoo coveys a lot to its customers. Started in 2005 by 

open source enthusiast ‘Fabien Pinckaers’, Odoo is now one of the leading open ERP providers 

across the globe. Started in the name ‘Tiny ERP’, and later as ‘Open ERP ‘, Odoo endured many 

adversaries before securing its present status. In the beginning, Odoo released everything for 

free. But later they have adopted a different business model in which the software and source 

code is still free, but customers have to pay for services provided by the Odoo service partners. 

The paradigm shift has brought enormous qualitative changes to Odoo. Odoo became powerful 

and user-friendly in consequent years and expanded its customer base, partner network, and 

community support [6]. And today with 2million+ customers and 730+ partner network, Odoo is 

one of the fastest growing open ERP solution in the world.  

 

A bulky software with higher cost is the first thing comes to a person’s mind while thinking about 

an ERP solution. But open source technology and new developmental methods have changed the 

picture altogether. Odoo is one of the simplest ERP solution available and you can witness it from 

the design of each module. In Odoo, each module is a separate app that can be installed to your 

database. That is where the word ‘expand as you grow’ is relevant. You just have to install the 

modules you needed most, and when you install a new module it will automatically integrate 

with your existing modules and start working.  

 

 

Why Odoo 
 

Comprehensive yet Simple to Use 

The 5000+ modules and apps it provides make Odoo a powerful ERP. There is always a solution 

for your any type of need. But this bulkiness will not reduce system performance, as the user has 

to install needed modules only. 

 

Highly updated and Regular Upgrades 

Odoo is a business solution that is designed to meet present as well as near possible business 

needs. Other than the classical modules like Accounting, Manufacturing, Sales etc. E-commerce, 

M-commerce, Business intelligence, Cloud assistance and more other modules make Odoo the 

need of the hour. 

Another widely appreciated feature of Odoo is that it is based on a technology stack that is 

modern and up-to-date. These technologies continue to be developed and adapted to the latest 

paradigms [5].  
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Customizable and Scalable 

Since it is an Open source solution, you can customize Odoo to meet your changing needs. Either 

you can customize yourself or you may seek a service partner’s assistance for more sophisticated 

customization.  Odoo Apps are another feature which keeps Odoo on top. The customer can 

access 10000+ free and paid apps from Odoo app store to add features to their software. 

 

Any Business with Less Cost 

From large enterprise to small organization, Odoo can serve any type of customer. It is simply 

customizable to cater any type of user needs. Similarly, the cost associated with it is affordable 

to any type of customer. If you need it for free, download and use it. If you need a service partner 

to assist then find an affordable hand from your locality. 

 

Strong and Active Community 

What makes Odoo an exception to other ERP solutions is its continued strong community 

support. With 20000+ members and developers, Odoo community is one of the best Open ERP 

community in the world. You can find help on any of the issues from Odoo community portals. 

 

Business Intelligence  

Odoo is not a conventional decision support system, rather it is more decision-making system. 

Various reports and analysis available in Odoo make your decision making simpler. And nowadays 

more AI apps and plugins are being contributed to Odoo App store, which in turn enhance the 

overall system capabilities. 
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Introduction. 

Free as in "freedom", not free as in "free services", this is the tagline presented by ‘Fabien 

Pinckaers’ (CEO, Odoo S.A) while adopting the new business model for open source ERP, Odoo. 

Thanks to such a visionary thought, without it, the idea of a game-changing open source ERP 

wouldn’t have become a reality. Freedom to see, freedom to change, freedom to use, everything 

based on user’s needs. That is the freedom offered by Odoo. You can acquire, customize and use 

an excellent ERP solution for free. Even a normal non-technical person can perform such 

operations. But we need a starting point, where to start and how to configure, how to customize 

up to your requirement etc. must be answered first. 

The following sections of this book will make you intimate with the system. In this introductory 

part, you will get to know about different ways to acquire Odoo. The first module of this book 

will explain how to set up the database of your ERP and manage it. It will also provide guidelines 

to set up different users with different access rights to manage the system. In the next section 

onwards the book will guide you to each module of Odoo in a detailed way. There you can find 

basic configurations, general operations and other important and advanced option to run each 

module. 

Basically, there are two versions of Odoo ERP available namely Community version and Enterprise 

version. While community version provides almost all the necessary features, later can provide 

more advanced options. You may acquire Odoo ERP solution through any of the following ways. 

 Online version – In this case you get online access to Odoo ERP Enterprise version. And 

all your data and operations are managed online. Here Odoo Company directly gives you 

all the services needed. 

 Direct download - You can download, customize and start using Odoo (Community 

version) your own. And you can access services and other helps from community portals. 

You may get the help of a service partner if needed. 

 Via Service Partner (Enterprise or Community version) – you can seek the help of an 

authorized service partner to implement and customize Odoo for you. However, the 

service partner may charge you according to service. You may choose either Enterprise or 

Community version depends on your need. 

Once you have acquired Odoo through any of these ways, the next step is creating your database 

(The detailed steps are described in this book). Actually, all the modules are independently 

organized in Odoo. In order to access a module, you must install that particular App from Odoo 

apps. But once it is installed, it automatically integrates with the whole system. 
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Core Modules of Odoo 

Accounting and Finance 

Simple yet powerful, Odoo Accounting module can be best described in these two words. You 

can process your transactions quickly using Odoo. Odoo’s accounting is connected with all other 

apps of Odoo like Sale, Purchase, inventory and Human resource. This makes working with Odoo 

more simple and quick. You can create a customer invoice by less than two clicks from a Sale 

order. (Check Sales for more details).Odoo will fill all the necessary information required for 

invoice automatically. To enable accounting features in you Odoo ERP you have to install 

Accounting and finance App from Odoo. 

Customer Relationship Management 

Integrated with Sales, Purchase and other modules, Odoo CRM effectively manages customer 

relation operations for you. Actually, Odoo CRM is a combination of about 8 Apps and plugins. 

View CRM module for a detailed explanation. 

Purchase 

Just like the sales, it is really easy to manage our purchase related operations using Odoo. We 

can generate quotations, convert them to purchase order and generate bills in simple steps. 

Illustrated reports generated by this module makes analysis even simpler. After installing the 

purchase management module from the apps list, we can see the menu item 'Purchases' in our 

Odoo ERP. 

Warehouse Management 

Track all the movements of products more effectively, generate automatic sales order and 

manage scraps in easy steps and lot more other features. Install the module ‘Inventory’ to enable 

warehouse management. 

Manufacturing 

For any manufacturing company, it is important to track products and every manufacturing 

orders efficiently. The Manufacturing Module in Odoo help you to handle the complexity of 

Production, Manage Bill of Materials, Plan Manufacturing Orders, and Track Work Orders etc. 

Manufacturing module is one of the basic application in Odoo. After a successful installation of 

Odoo, we can find the Manufacturing app in apps. Since the manufacturing is highly integrated 

with Inventory Management, you can keep your inventory automatically updated with each 

manufacturing process. 
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Human Resource 

For an efficient HR management using Odoo, you have to install following apps from Odoo. That 

is, Timesheet, Employee Directory, Leave Management, Recruitment Process, Expense Tracker, 

and Attendants. One of the useful features of Odoo HRM module is the automation of 

recruitment process with the help of the website. 

Point of Sale Management 

The Simple and user friendly interface of Odoo Point of sales module let the user to configure 

and complete his all POS needs with hassle free steps. You can install POS app from Odoo to 

enable this module. Like other modules, POS is also integrated with Inventory, Accounting and 

CRM modules thus providing live updating and efficient management. 

Website and E-commerce 

Odoo is always ahead of user needs. Website and E-commerce is such a novel feature. You can 

make your own website and carry out E-commerce activities without depending on other third- 

party apps. Website also plays a big role in many other modules. 

Project Management 

Project Management is a collection of guided process to achieve a specified target. That may 

include initiation, planning, assignation, controlling, analysis and closing. Project management 

app is one of the powerful tools in Odoo. Where we can run all projects with user-defined 

workflow. To enable project management functionalities in Odoo, you need to install Odoo 

Project App. 

The following pages will give you an exact idea about Odoo and its modules. 
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Basic Configurations of Odoo 
 

You can acquire Odoo through any of the methods mentioned in the previous chapter (i.e. 

Introduction). The very next step is setting up your database. Whether you are using online 

version or onsite version, you must create your database first. It is in this Database all your data 

and operations are performed.  You can create multiple databases if needed, and you can have 

different administrators for each of them. An administrator account (super user) will be created 

automatically when you create your first DB. This Administrator account is very important as he 

enjoys complete control over ERP system. Odoo provides an extra level security called Master 

Password to protect your database from unauthorized modifying. You may have multiple 

databases and administrators but only the administrator with Master Password can modify the 

entire database. Once you have configured a database, Odoo provides the option to delete, 

Backup, Restore the databases. Backup and Restore option is a useful feature provided by Odoo 

to protect your database. 

 

After setting up your database, it is time to install the modules you needed from Odoo Apps. In 

upcoming chapters, you can find the detailed description about the apps you need to install to 

run a module. 

 

In the next step, you have to create the system users. System users mean all the persons who 

can login and access different sections of ERP. For example, accountant, project manager, section 

head, department head, team lead etc. This depends upon the business and organizational 

hierarchy you run. Obviously, you can set access restrictions on this users. The menu and settings 

visible to each user are based on the access right he possesses. For example, the menu to create 

a manufacturing order will be visible to a user with ‘Manager’ privileges in manufacturing.  In 

each module, Odoo by default provides at least two type of users with different access 

permission. However, the administrator can grant custom permission to these users if needed. 

In fact, admin can create a user with custom privileges. Another useful feature you can find in 

Odoo is the ‘Group’. You can add multiple users under a Group and apply access restriction on 

the group. In other words, if you have a lot of users to manage, then the group is an efficient 

method. 

 

Odoo has multilayer security system. At the top level, the administrator can restrict an individual 

user from accessing any module or application in Odoo by using Access Right mechanism in the 

user profile. Further down, the administrator can Impost Read, Write, Delete, Create permissions 

on Groups (i.e. any Department or a group of people) using Access control to fields. Record Rules 

is another feature to establish customized security. 
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Database Management 
 

Create Database 
 

When we install Odoo in our system we automatically redirected to database creation page.  

In that page, Odoo provides basic instructions for creating your database. 
 
 

Note: - Tick the checkbox Load Demonstration data to fill your apps with sample data. 
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Click <Create Database> and you will be redirected to Odoo Apps. You can see the Apps from the 

app list, install any module according to your need. 

Note: - You can create any number of database later from the same window. 
 

 
 

 

 

Delete Database 

 Manage Database -> Delete
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Backup and Restore Database 
 

To Backup a Database 
 

 Manage Database -> Backup

 Select the Backup format and click on <Backup>.



To Restore a Backup, Follow the steps

 Manage Database -> Restore

Choose the database to be restored, Give the database a new name and click on 

<continue.> 
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And after successful restoration we can see the restored database listed in the database 

management page. 

 

Duplicate Database 

 Manage Database -> Duplicate

 
 

And After a few seconds, we can see the duplicated database in the database list. 

Master Password 

Master Password is the key-stone element which controls entire Odoo Databases. Database 

creation, deletion, duplication etc. actions can’t be performed without the master password. 

So it is advisable to create a strong master password for your Odoo system. 

 

USER Management 
 

Types of user 
 

Basically, there are two types of user in Odoo ERP, Administrator, and normal user. Administrator is 

the default user created at first and he has complete access over Odoo system. As the administrator 

of your database, you are responsible for its usage. This includes the Apps you install as well as the 

number of users currently in use etc. Admin can create as many as users and assign their permissions 

and access rights within the application. By this method, admin can create organizational hierarchy 

and restrict users only to their own domain.  
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Creating user 

 Login to the system as administrator

 Settings -> Users -> Create



 Fill the field with user information

 Set Access Rights to each application for the user from dropdown

 Find more customization for the user in ‘Oauth’, ‘Preferences’, ‘Point 

of sale’ tabs.

 ‘Change Password’ button can be used to set a password for the user

 

Note: - you can restrict a user from accessing a particular application by changing Access Right for 

that application from above form. 

 

Note: - Admin can edit any user details from the same menu (i.e. More->Settings->Users) by 

Clicking on the user name from list. 

 

Delete User 

 Login to the system as administrator

 Settings -> Users

 Select a user from list
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 Action->Delete

Note: - Admin can perform other tasks like ‘Edit user info’, ‘Duplicate’ user etc. from the same window. 

 
Groups 

 

Groups are very important security modules in Odoo. They are created to achieve organizational 

hierarchy as well as impost access control to a group of users. Admin can set access control for a group 

of people rather than an individual. 

Assign user to groups 

 Settings > Groups

 

Once you know about groups, you can select groups from list of groups as shown in above figure. 
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Here you can add as many as users under the Users tab so that all the security rules in that group will be 

applied to the user. Access Rights and Rules are very effective methods to implement security measures 

in Odoo, they are discussed in coming pages. 

 

External user Sign Up 

What if we wish to allow an external user (like your client) to view something in your system.   

He can sign in to your system and view allowed areas. To enable this settings. 

 Settings -> General Settings

 

Under The portal access there is a check-box indicated Allow external users to sign up .Tick 

that checkbox and click on <Apply> button. Now you can see a signup option is enabled near 

login portal 

19



 

 

Click on <Signup> and you will be redirected to a new Sign Up page. 
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Security Rules 
 

Other than the access permission applied during the profile creation, admin can make use of 

following security measures to achieve high-level system security. 

Access control to fields 
 

In Odoo, all menus and views are not viewable to all users, by default only administrator has 

the permission to view and control all the fields and views. Following are the major access levels 

an administrator can enforce on Groups. For example if you want to restrict some users in 

inventory from editing inventory details such settings can be established with this option. 
 

1) perm_read 

If this is set, it means that all users that are in this group have read access on this model. If 

it is not set, it means that the users don’t have read rights. 

2) perm_write 

If this is set, it means that all users that are in this group have write access on this model. 

3) perm_create 

If this is set, it means that all users that are in this group have create access on this model. 

4) perm_unlink 

If this is set, it means that all users that are in this group have delete access on this model. 
 

This settings can be found on following tabs 

 Settings > Groups > Access Rights

 Settings > Groups > Rules
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Record Rules 
 

This control mechanism is applied when we need more customization in access rights other 

than the one which are available. These are generally done by technical persons. 

 Settings > Security > Record Rules

A record rule has: 

 A model

 A set of permissions (e.g. if perm_read is set, the rule will only be checked 

when reading a record)

 User groups (no group means global rule)

 A domain for filtering data (If filter matches: It is accessible, If filter does not matches: 

It is not accessible )
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Accounting and Finance 
 

Simple yet powerful, Odoo Accounting module can be best described in these two words.   You 

can process your transactions quickly using Odoo. Odoo’s accounting is connected with all other 

apps of Odoo like Sale, Purchase, inventory and Human resource. This makes working with Odoo 

more simple and quick. To enable accounting features in you Odoo ERP you have to install 

Accounting and finance app from Odoo Apps. 

 

There are many things which make Odoo a unique product than any other ERP Accounting 

modules. When we compare Odoo Accounting with other ERP suites like Microsoft Dynamics and 

NetSuite we can see many features which Odoo alone have. For example, Quick reconciliation, 

Automatic Sync, Batch Send, Third party follow-up, Payment automation, Alerts, and Expenses 

etc. features can be found in Odoo. But neither NetSuite nor Dynamics support all of these 

features but only some of them. Since all accounting transactions are associated with customers 

or suppliers, you get reports to perform analysis per customer/supplier such as the customer 

statement, revenues per customers, aged receivable/payable etc. Another exemplary option 

available in Odoo is its business intelligence engine which will allow you to navigate through 

company data in more organized manner. The graphs and diagrams plotted by BI engine is indeed 

a useful tool in decision making. Of course, Odoo is mobile too. You can use it to check your 

accounts on the go. 

 

Following is the way Odoo deals with typical accounts and transactions. 

 

Double-entry bookkeeping 

Odoo automatically creates all the journal entries for each of your accounting transactions and 

Odoo uses double-entry bookkeeping system i.e. all journal entries are automatically balanced. 

 

Accrual and Cash Basis Methods 

Odoo support both accrual and cash basis reporting. This allows you to report income / expense 

at the time transactions occur. 

 

Multi-companies 

Odoo allows to manage several companies within the same database. Each company has its own 

chart of accounts and rules. You can get consolidation reports following your consolidation rules. 
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Multi-currencies 

Every transaction is recorded in the default currency of the company. For transactions occurring 

in another currency, Odoo stores both the value in the currency of the company and the value in 

the currency of the transaction. Odoo can generate currencies gains and losses after the 

reconciliation of the journal items. 

 

International Standards 

Odoo accounting support more than 50 countries. The Odoo core accounting implements 

accounting standards that is common to all countries and customized apps are available to 

accommodate the specificities of individual country; like the chart of accounts, taxes, or bank 

interfaces. 

 

Accounts Receivable & Payable 

By default, Odoo uses a single account for all account receivable entries. 

 

Wide range of financial reports 

 In Odoo, you can generate financial reports in real time. Odoo's reports include: 
 

 Performance reports (such as Profit and Loss, Budget Variance) 

 Position reports (such as Balance Sheet, Aged Payables, Aged Receivables) 

 Cash reports (such as Bank Summary) 

 Detail reports (such as Trial Balance and General Ledger) 

 Management reports (such as Budgets, Executive Summary) 

 

Import bank feeds automatically 

Odoo makes bank reconciliation easy by frequently importing bank statement lines from your 

bank directly into your Odoo account. 

 

Inventory Valuation 

Odoo supports both periodic (manual) and perpetual (automated) inventory valuations. 

 

Easy retained earnings 

Odoo automatically calculates your current year earnings in real time; so that no year-end journal 

or rollover is required. This is calculated by automatically reporting the profit and loss balance to 

your balance sheet report. [7] 
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System Users 
 

Basically, there are three types of users in Accounting module, who have different type of access right to 

the system. 

 

● Billing 

● Accountant 

● Adviser 

 

When we move from Billing Adviser, user will get more rights in application 
 

 The main thing a user with only ‘Billing’ access right can do is 

create and process invoices.

 Billing user  can also create new customers and vendors,

Access product information, taxes, and fiscal positions. 

 

  

25



 

 

This is all the menus available for a ‘Billing’ user.  
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Next level of access right is ‘Accountant’. Along with the rights available for billing user, 

Accounts has more other rights. 

 Accountant have  access to  dashboard of accounting

 Accountant can record payments from customers 

and vendors.

 He can generate all the PDF reports available.

 Also Accountant can configure financial reports.
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 Advisor level user have more rights than any other users in Odoo accounting. 

 

In addition to all the rights Accountant have, 

 Advisor can create products and services, they can create journal entries, Manage chart 

of accounts, manual payments and invoice reconciliation, and advisor can make manual 

tax adjustment.

 

 Advisor level user can create new journals and new payment terms in Odoo.
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Basic Configurations 
 

First, we have to set up general configurations of the Accounting system. You can find the 

basic and important configuration below. 

 

Accounting>Configuration>Settings-> Chart of Accounts 

Here we have selected the Indian chart of account. This is a Chart of account that comes along 

with Odoo. Odoo will automatically select Chart of account related to the country you selected 

while creating a database. 

 

There is more than 50 chart of accounts comes with Odoo. You can choose as per your locality 

and need. 

 

Accounting>Configuration>Settings-> fiscal Year 

 

In this section we can set-up our financial year (Fiscal Year) related controls. 

 From Odoo version 9 onwards, Odoo removed financial closing. But we can 

configure financial year last day
 

Lock Entries are to prevent editing accounting entries 

Lock Date for Non-Advisers means a Non-Adviser level user cannot edit an accounting entry 

created on this date and prior. Usually, we use this for closing a period inside an open financial 

year. 

Lock Date means, not even advisor level user can edit accounting entries created on or prior to 

this date. 
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So the benefit of this approach is we don't have to close financial year to get clean Profit & 

Loss and Balance Sheet report. Reports will be always up-to-date without closing and 

generating opening entries. It makes Odoo’s reporting much easier and powerful. 

 

Accounting>Configuration>Settings-> Accounting and Finance 

 

This section is very important. 

This is where we are configuring what are the features we need in our Odoo accounting system. 

First thing is Default Company Currency. 

 

 You can change the currency rate by clicking this button. It will open a window like 

this

 

By clicking on ‘View Rates’ button at the top, you’ll see a list view of currency rates. 
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Add the current rate of your currency here by clicking <Create> button. 

 

Note: All the options those are labeled as   are available only in enterprise version 

of Odoo. We will not discuss those things here. 

 

Accounting>Configuration>Settings 
 

● Analytic accounting. 

This feature can be used for many purposes like Manage Cost center concept, Invoice 

time spend on a task, Performance Analysis. This feature is also using for the budget 

management. 

We will discuss these matters later 

● Asset management. 

Choosing this feature let you purchase your asset and manage the depreciation of 

those assets 

● Budget management. 

● Allow Tax Cash Basis. 

Odoo supports both accrual and cash basis approach. This option allows your system 

to generate report in cash basis. 
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Accounting>Configuration>Settings>Multi Currencies 

 

 

Enabling this option allows handling multiple currencies   in   Odoo. System will give a new 

option to select Rate Difference Journal when you check this checkbox. 

 

If we receive payment against an invoice after a month of invoice creation, the exchange rate 

most probably changed. This Rate Difference Journal is used to create journal entry of loss or 

profit caused by the difference of currency exchange rate. 

 

Accounting>Configuration>Settings>Invoicing and Payment 

 

Under this section, if you check Allow pro-forma invoices, it will let you set your invoices into   

a state called ‘Pro-forma’. 

If you have to set up any restriction or a warning message for any partner while you create an 

invoice for him, select An informative or blocking warning can be set on a partner option 

under warning. 
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The tax selected as Default Sale Tax and Default Purchase Tax will be assigned as Customer 

Tax and Vendor Tax of a Product/Service When you create a new one. 

 

Configure payment acquiring methods Button will redirect you to the list of all Payment 

acquires available in Odoo. You can install the payment acquirer from that list and you can also 

configure them. 

 

 

Enabling Use Anglo-Saxon Accounting will change your system’s behavior into Anglo-

Saxon. By default, Odoo uses continental accounting. 

 

Bank account prefix and Cash account prefix are used to generate codes for bank and cash 

accounts. And # of Digits represents the number of digits in account code. 

 

You have two options in Tax calculation rounding method 

● Round per Line 

Tax amount will be rounded in each invoice line. 

● Round Globally 

Rounding occurs only on total tax amount. 
 

 
 

Overdue payments Message is used on overdue report of partners.  So that you can 

generate the report and sent it to your customer/supplier without making any modification. 
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Let’s move to the other parts of configuration. 

Configure Customer/Supplier 
 

How to configure a customer and other related things are covered under CRM 

module, however Accounting related fields is just mentioning here. 
 

 

 

As we see in the picture, we can select Customer Payment Term and Vendor Payment 

Term for this client. Total Receivable and Total Payable are only visible in developer 

mode. 
 

We can select the Degree of trust you have with this partner and also Fiscal Position. 
 

Account Receivable and Account Payable will have a default value. But you can 

change if you want. 
 

Configure Products 
 

Under the Invoicing tab of product form, we have 

● Income Account 

● Expense Account 

● Customer Taxes 

● Vendor Taxes 
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Add New Account 
 

While we install Odoo, we had the option to choose our country. Using that data Odoo will install 

that country specific COA(Chart of Accounts). If you need more accounts in COA. You can create 

that from ‘Chart of accounts’ menu. 

 
Accounting -> Advisor -> Chart of Accounts



 We should be careful while selecting the Type of accounts. You can use the details 

provided on the right side of the window to select correct type.
 

 If we select any tax as Default Tax on an account, and we don’t have any tax 

mentioned on product, then system will select this tax by default on invoices.
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 We have to check the Allow reconciliation option. This account is used for 

Invoice and payment matching and reconciliation.
 

 If we mark an account as Deprecated, we cannot use that account anymore. We 

will get a warning message like this.

 
 

 

If you select an Account Currency, the system will force all moves for this account must have 

same currency. 

 

Configure Taxes 
 

In Odoo we can create different type of taxes. To create a new tax or list all the taxes 

in your system, 
 

Accounting > Configuration > Accounting > Taxes 
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In the above picture you can see the mandatory fields for a tax. 

● Tax Name 

Name of the tax 

● Tax Scope 

Where to use this tax. If you select ‘None’, you can only use this tax with other tax 

group. 

● Tax computation 

Odoo have four different types of tax computation 

○ Group of taxes 

○ Fixed 

○ Percentage of price 

○ Percentage of price tax included 

 
Some other options are 

● Tax account 

The account, that will be used in the invoice tax lines. Later journal entries are 

created using this account. If we leave it empty, then Odoo will take the default 

debit/credit account of Journal. 

● Tax account on refunds. 

The account used in case of refund entry. 

● Label on Invoices 

This can be used on the invoice report to represent this 

tax. We can add custom tags to create custom reports. 
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● Include in analytic cost 

If we set this option, then the amount computed by this tax will assign to the same 

analytic account mentioned the invoice line. 
 

● Included in price 

Set this option if this tax is included in the unit price of the product/service. 
 

● Affect base of subsequent taxes 

If you set this option, Base amount of subsequent taxes will be sum of current base 

amount and tax amount of this tax. 
 

● Tax adjustment 

Set this option if you want this tax to be used in tax adjustment wizard. 
 

● Group of taxes 

This option lets us configure the tax as collection of many child taxes. Odoo will make 

visible the table to select the child taxes when you select this option as tax computation 

method. 

 

 

 

Configure Fiscal Positions 
 

Odoo can handle Multi Company and multi-currency concepts. Those who are dealing with us, 

i.e. Customers and Suppliers, may be operating from another country or states. So the laws 

and regulations will be different for them. Fiscal position comes in handy in this case. We can 

map taxes and accounts using fiscal position. 
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Accounting > Configuration > Accounting > Fiscal Position 

 

Tax mapping is another useful option to configure taxes. 

 

For example: 

 

 

Here this product’s vendor tax is configured as VAT 10%. What if I cannot purchase this product 

from some vendors with this tax rate (assume the tax rate is more than 10%, let’s take it as 

12%). In this case we can use tax mapping of fiscal position 
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Let’s specify this fiscal position on partner master. 

 
 

 
 

 Same we can do with accounts.
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Configure Bank Accounts 
 

Accounting > Configuration > Accounting > Bank Accounts. 

 
Here you can see the list of all the bank accounts configured in this system. To configure a new one 

click on the <Create> button. It will open a form to fill the details needed. 

 

 

Show in Invoice Footer, if we enable this feature, this account details will be displayed on 

Invoices and Sale orders. 

 

Debit method is the method of collecting money and Payment method is the method for 

sending money 

Different modules provides different methods, select according to the need. 

 
Create/Select the bank from list of banks 
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Configure Journals 
 

Accounting > Configuration > Accounting > Journals. 

 

Mandatory fields are 

● Name 

● Type 

There are five types of journals in Odoo. 

○ Sale: Using for customer invoice journal 

○ Purchase 

○ Cash 

○ Bank 

○ General 

 
● Short Code: 

Odoo will create a sequence number for each journal we create. Journal entries of this 

journal uses this short code as the prefix of generating sequence.  

 

There are some other fields 

● Default Debit Account: 

It is the default account for debit amount. 

● Default Credit Account: 

It is the default account for credit amount. 

● Currency 

We can specify the currency used to enter statements  
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here. Some additional options are available under ‘Advanced Settings’ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Under Control-Access area, we can set some control on this journal. But these are only visible 

in Developer Mode 

● Account Types Allowed: 

If we mention any accounts here, this journal can only create entries to that type of 

accounts 

● Accounts Allowed: 

Just like types, if we mention accounts here, Journal can’t use accounts other than 

that.  

● Show Journal on dashboard: 

Checking this option will add this journal details in to dashboard as a tile 

 

Configure Payment Terms 
 

We may have to use different payment terms like, immediate payment, 30% advance and 

balance after one month, etc. in different situations.  We can manage this with Odoo’s 

payment terms 
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Payment term have different due types. 

● Balance 

● Percentage 

● Fixed amount 

Also different due date computation parameters 

● No of day(s) after the invoice date 

● No of day(s) after the end of invoice month 

● Last day of following month 

● Last day of the current month 

We can use the combination of these to create a new payment term. 

 

For example:- 

Payment term: 30% Immediate and balance at the end of the current month. In this case, 

we have to create a payment term with two of the above due types  
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As you can see in the above picture, we have added 'Percentage' and 'Balance' lines under 

terms. 

 

In percentage, 

 

We have to select '0 Day(s) after the invoice date' and put the value as 30.0 

 

In balance, 

We choose the 'Last day of current month’. 
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Accounting Dashboard 

Odoo have a nice and simple dashboard. You will get status of your accounts from the 

dashboard itself. 

You can also go to many other parts of your accounting app from this dashboard. 

 

 

You can create new customer invoices, vendor bills, new Bank statements, and new cash 

transactions from this dashboard. 
 

 

When you click on ‘More‘, you’ll see more related options. 
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There is a lot of features accessible from Dashboard. You can go to the list of different records, 

create new records,   you can do payments matching from dashboard itself. 
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Creating and Processing an Invoice 
 

Accounting> Sales> Customer Invoice> Create 

 

Invoice in Odoo have five states. 

 
1. Draft: 

  Draft status is used when a user is creating new or unconfirmed invoice 

2. Pro-forma: 

Pro-forma status is used when invoice don't have a sequence number. This status is not always 

active. We have to enable this from account settings by checking “Allow pro-forma invoices“ 

3. Open: 

An invoice becomes open when the user validates the invoice. From this stage onwards invoice 

will have a sequence number generated by Odoo itself. Invoice will remain in this   state   till   

the   user   registers   payment   for   the   full   amount   against   this   is   voice. 

4. Paid: 

When the invoice is fully paid. 

5. Cancel: 

  Cancel status is used when user cancels an invoice. 
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You can see the current status of the invoice in the status bar 

 

 Click Add an Item to add products to your Invoice

 

 

You can see other information related to this invoices under ‘Other info’ tab 

 

 

Still our invoice is in ‘Draft’ state. A draft invoice won’t make any difference in accounting. 

Accounting entries are created only after the validation of Invoice. 

 

Validating an invoice will confirm the invoice. It will create a journal entry, invoice will get a 

sequence number, and invoice state will be in ‘Open’. Now we can make the payment against 

that invoice. 

 

 You can validate an Invoice by clicking ‘Validate’ button.

 

See the sequence code and journal entry created for this invoice in the picture below 
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This is the journal entry 

 

See the debit and credit posting of the entry from this picture. 
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By clicking the ‘Register Payment’ you can record a payment against this invoice. 

 

 

We can choose a payment journal (cash/bank/..) here and the payment amount will be the full 

residual amount of that invoice. If we are recording a partial payment, then we can change the 

value there. 

 

 State of the invoice will become ‘Paid’ once we record the full payment against it.

 
If the customer made any advance payment or he has any previous balance in our system, Odoo 

will inform you that this way 
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You can assign that outstanding balance by clicking add button on that outstanding payment 
 

Payments 

You can Create/List all the list of customer payments and vendor payments from payments 

menu. 

 

Payments have four states 

● Draft 

● Posted 

● Sent 

● Reconciled 

A Draft payment becomes Posted when the user clicks on validate button. Becomes Reconciled 

when it is assigned against an invoice. 
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Manual Payment & Invoice Matching 

 

 

This feature allows user to match the payments and invoices and reconcile them. Odoo itself will select 

the most matching entry. If you want to change we can do that. 

 

You can also access this from the dashboard.
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Manual Tax Adjustment 
 

This feature is used to manually correct the VAT declaration through a miscellaneous operation 

 

Here you can only select the taxes marked as ‘Tax Adjustment’. 

Submitting data will create a Journal entry with the details provided 

 

 

Working with Bank Statement 

You can create a new bank statement and map those transactions with the general ledger 

transactions in Odoo. 

 

Using the New Statement button we can create a new bank statement. That will open up a form 

like this 
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Here you can put all the details of transactions. A bank statement have two states 

● New 

● Validated 

 

We have to reconcile the statement to make it Validated. 

 

 

Odoo  will  select  the  most  matching  bank  transaction  record  from  general  ledger same as 

payment matching. 

Clicking the Reconcile button will complete the process. 
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Asset Management 

Odoo’s asset management allows you to track your fixed assets like, equipment, furniture, 

vehicles, land, etc. You can purchase, sell and manage depreciation using Odoo 

 

We can configure asset categories in Odoo. This will make things easier for normal users by 

providing complex details in category and use it in assets. 

 

Create Asset Type 

Accounting > Configuration > Management > Asset Type 

 

 

Advisor can give the appropriate accounts for generating journal entries here. He can also 

provide details to compute the depreciation. There are many things to provide 

 

● Time method based on: Method to compute the depreciation date and number of 

depreciation lines. We have two options here. 

○ Number of depreciation: by choosing this option we are fixing the number of 

depreciation and the time between two depreciations. 

○ Ending date: This way, instead of giving the number of depreciation. We give 

the date that depreciation will not go beyond 
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● Computation Methods: Here we can choose the method to use for computing the 

depreciation amount. Here also we have two options 

● Auto-confirm Assets: Ticking this option will auto confirm all the assets comes under 

this category when they created from the invoices. 

● Group Journal Entries: if you want to group the journal entries generated using the 

category, tick this option. 
 

Create Asset 

We can create an asset in two ways: 

 Manually  

 From Supplier Invoice To create an asset manually,  
 

Accounting> Advisor > Assets 
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Here we can fill the details of your asset 

● Salvage value: this is the amount you plan to have that cannot depreciate 

● Vendor: The vendor from we purchased this asset 

● Invoice: The invoice related to the purchase of this asset 

 
An asset have three states 

● Draft 

● Running 

● Close 

 
Once we created an asset, we should confirm it. We can also click on the Compute Depreciation 

button to check the depreciation board before confirming the asset. 
 

 

Then the asset will change to Running state you can see the depreciation board
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The red button indicates that related journal entry is not created and green bullet means that 

the journal entry has created for this line 

You can sell or dispose the asset using the Sell or Dispose button on status bar. It will create a 

journal entry to post the full expense of the asset. But it won’t create a sale entry or an invoice. 

 

To modify the depreciation of an asset, Click on the <Modify Depreciation> button and provide 

the values accordingly. 

 

 
 

Creating an asset from supplier invoice is easier.
 

We just have to give the asset category. Odoo will create asset based on the data in category 

and invoice. If we set asset category in product itself, then asset category in invoice line will be 

automatically selected. 

 

Asset will be automatically confirmed if we tick the asset category option Auto-confirm Assets. 
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 Accounting> Advisor> Generate Asset Entries, is an option to trigger the generation 

of asset depreciation entries

 

 

Analytic Accounting 

Odoo have a feature called analytic accounting. This is an advanced feature that we can use for 

different purposes. Like, 

● Cost center concept 

● Timesheet invoicing 

● Project management 

● Budget management 

We have to enable analytic accounting first from settings to use this feature. 

 
We have to create analytic accounts here, 

Accounting> Configuration> Analytic Accounting>Analytic Account. 

 

You can select a customer for an analytic account. Then, this will be added to the name of 

analytic account. It will make the selection of analytic account easy.  
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Now you can select this analytic account in Invoices. 
 

 
 

Let’s check the changes this makes. 

 

Here we can see that each debit entry have analytic entries selected. This will create an analytic 

entries in Odoo. You can see the analytic entries under Accounting> Advisor> Analytic Entries. 
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These are the analytic entries created. Unlike general accounting journal entry, analytic entry 

don’t have debit/credit. It is handled with negative and positive value for ‘amount‘. 

 

 

By clicking this Cost/Revenue smart button we can see the analytic entries of that account. 
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Budget Management 

Budget management plays an important role in the success of any business. We can check our 

financial status with the planned details using Odoo’s budget management section. Odoo uses 

its general and analytic accounting in budget management. 
 

We need to configure three things to work with Odoo budget management 

 Budgetary Positions 

 Analytic Accounts 

 Budget 

 

Budgetary positions are a kind of mapping the general accounts with budgets Let’s create a 

budgetary position. 
 

We can create budgetary position from Budget form itself,  

                          Or we can create from 

 Accounting>Configuration>management>Budgetary Position

 

We are now creating a budgetary position Income. 

 

 
We have selected some General accounts under this budgetary position. Same way we are 

creating another one, Expense. 
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Now we have two budgetary position in our system. 

 
The role of analytic accounting comes when we have to get the details based on a specific 

Customer/Supplier or a project. We already discussed how we can create an analytic account. 

 

So we are moving to the configuration of budget. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As we can see on the picture, we have to give a Name for budget and also a 

Period. Then we must add our budgetary positions we already created to this 

budget. 
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At that time we have to provide our planned amount to that position. 
 

 
 

 Add other necessary fields you need.


 

Now you can see there is four columns in the table 

 Planned amount: The amount we gave 

 Practical Amount: It is the actual amount 

 Theoretical amount: It is the amount we could have spent/ received till today 

“If the planned amount is 12000 then for one year, then on January 31st the 

theoretical amount will be 1000. On May 31st it will be 5000, On December 

31st it will be 12000.” 

 Achievement: percentage of practical amount with respect to theoretical 

amount. 

 We have to Confirm and approve the budget                            

 You can check the budget any time.
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Customer Relationship Management 

 
Customer Relationship Management, which is the most important part of a business, is 

simplified with Odoo CRM system. Odoo CRM is a combination of 8 Apps and Plugins. For 

efficient management of customer relation, you must install all the following Apps/Plugins. 

 

 CRM 

 

And following optional apps can further enhance CRM capabilities 

 

 CRM Gamification 

 Marketing campaign 

 Survey CRM 

 Contact Form 

 Resellers 

 Lead to Issue 

 Opportunity to quotation  
 

Since any discussion on CRM can’t be completed without sales procedure, in this section we 

will explain CRM combined with sales module. To get sale features in your ERP you have to 

install following apps from Odoo. 

 

 Sales 

 Sales Teams 

 Sales and MRP management 

 Margins in sales orders etc. 
 

The first application ‘sales’ alone can facilitate all sales related procedures rest is options. 

However, for a better sales management, you may install rest of the apps also.  You can find 

more related applications from Apps tab in your ERP. 
 

Comparing to other CRM applications like SalesForce, Zoho, and Sugar CRM Odoo has a lot of 

unique features. If we consider the case of ‘Salesforce’ Odoo has an advantage of features like 

Price list, Quotation Templates, eSignature, Online Payment, Invoicing, Customer Portal, 

Shipper Integration, Leads Tracking, Social Network Integration etc. If it is in the case of Zoho 

the list changes to Pipeline management, Next Action, Multiple companies per contract, 

Pricelist, Quotation Templates, eSignature, Drag and Drop management etc. Undoubtedly Odoo 

user interface is the easiest and user-friendly among all these CRM’s. 
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Some of the useful features of Odoo CRM includes 

 

 Priorities activities 

Priorities the follow-up activities in pipeline and meet your targets efficiently  

 Track your sales activities. 

Track the sales stages more easily via sales pipeline Kanban view.  

 Schedule Meetings 

Schedule meetings directly from the opportunity of customer 

 Dashboards 

Get all the necessary details of ongoing and done business activities in your Dashboard 

 Get in touch with customers 

Maintain Communication with customers via email, phone, chat, and social media from 

within your Odoo CRM. 

 Leads Promotion 

Start campaign by sending auto generated emails to customers in Leads. Assign a 

salesperson to follow the lead and promote it. 

 Opportunities Analysis 

Analyze your opportunities pipeline with advanced filters, grouping, drill down, etc. 

 Lead Scoring 

Score your leads based on explicit and implicit criteria and decide which lead satisfies the 

benchmark to become opportunity. 

 Customized Alerts 

Set custom alerts for opportunities based on some activities 

 Analyze Opportunity lost  

Analyze the reasons behind the loss of opportunities and improve your sales efficiency. 

 GeoIP 

Detect countries, states and cities of leads automatically from your visitor IP address. 

 Automate routines and Focus on sales  

Automate routine business activities, don’t waste time on maintain data. 
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Odoo CRM general workflow 

 

CRM in Odoo can be explained as a series of events that start with identifying a Lead (a future 

sale possibility) and passes through different stages like Opportunity, Quotation, Sale Order 

and actual sale (invoice generation and payment). Odoo integrates Customer Management 

module along with these processes to accomplish effective Customer Relationship 

Management. The basic steps involved in tracking a sale can be listed as below 

Lead: - A possible future sale, it may be created just because a user enquired a product 

Opportunity: - More possibility of sale. Here onwards the organization may appoint a person to 

follow-up the customer. 

Pipeline: - it is a convenient mechanism provided by Odoo to track Opportunity. You can create 

many stages based on the possibility of the Sale and track more effectively. 

Quotation: - once the opportunity is Won, then next level is to make a quotation and send to 

the customer. 

Next, Quotation changes to Sale Order and then to Invoice Generation and Payment. 

 
System Users 

There are three types of default user as far as CRM (Including Sales + Purchase + Customer 

Management) module is concerned. 

Manager: - who will have complete access over all these Sales, Purchase modules 

User - Own documents only: - This user will have the permission to control the documents and 

entries created by him. For example, you can restrict a sales executive from accessing another 

sales executives documents. 

User - All documents: - may be a sales head, he has to view all the documents by all sales 

representative. 
 

 

Customer Management 

Create customer 
 

Basically, in Odoo CRM a person you add is called Partner rather than Customer i.e. you can 

keep the entity both as a Customer and Vendor 
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 Sales -> Customers -> Create

 

Tick Is a Customer, Is a Vendor check boxes in Sales & Purchases according to the nature of entity.

 Use Partner Assignation tab to track Geo-location of customer

 Accounting tab can be used to add accounting info of the entity.

 Choose between Individual , Company radio button accordingly

 Click on Active button to activate the profile for use (otherwise it will not be listed 

elsewhere.

 

If we go to the Sales & Purchases tab, we can specify a salesperson who is in charge of 

communicating with this customer. We can also choose that this customer should be able to 

receive email notifications or not. If this option is enabled, then this customer will receive 

emails for each notification in his inbox. 

 

The field, 'Mailing Opt-Out' is really useful in cases where we don't need to receive any emails 

from mass mailing or marketing campaigns. If this option is enabled, this customer won’t 

receive any emails from mass mailing and marketing campaigns. The Number of bounced 

emails will be displayed in the ‘Bounce’ field. 

 

For providing portal access, we need to configure the email and enable the 'In Portal' option 

for those customers. 
 

69



 

 

 

Upon clicking on the 'Portal Access Management' option, a new wizard will appear. Here we can 

enter the email address. The option ‘In Portal’ should be selected for those contacts to whom we 

wish to enable the portal access. Once we have filled the details and applied, an email will be sent 

to the specified email address. With the portal access enabled, the user can sign in to Odoo from 

the link provided in the E-mail 

 

Update/Delete a Customer Details 

 Sales -> Customers

Click on any of the Customer from Kanban view 

 Click <Edit> to make modifications

 Or find more Details related with the customer from Action tab



Note: - “You can directly jump to the opportunities, meetings, invoice, Tasks, Ledger and any 

details linked with your customer from this window.” 
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Product Management 
 

To sell any product, we must create a product or add a product to our inventory. Though it is an 

activity done udder inventory management, Oddo Sales module provides a quick link under  

Sales > Products tab to perform product management functions like Add Product Update Stock 

etc. To see the full functionality and processes in Product Management refer Inventory 

management module 
 

Pre-Sale Tracking 

Lead Generation 
 

For handling our leads with Odoo, first we have to enable the leads option from the settings. 

 Sales -> Configuration -> Settings
 

After this option is enabled, a new menu for creating the leads will appear. 

 

 Sales -> Leads -> Create

 

In the lead creation form, we can select a customer or we can create a new customer and link 

to this lead. Complete address of this customer can be specified here. There are some optional 

fields such as email, contact name, job position, mobile, phone, fax, etc. are available. The 

corresponding salespersons details who creates this lead will be automatically filled and his 

sales team will also be selected automatically. 
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Or you can generate Leads from Incoming Mails 

There are several ways for your company to generate leads with Odoo CRM. One of them is using 

your company's generic email address as a trigger to create a new lead in the system. In Odoo, 

each one of your sales teams is linked to its own email address. You can configure this E-mail to 

generate Leads automatically. For this, first we need to configure the Incoming & Outgoing mail 

servers from settings. 

 

 

Opportunities 

 Sales -> Leads

 Click Convert To Opportunity
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If we select the conversion action ‘Convert to opportunity’, then a new opportunity will be 

created. If ‘Merge with existing opportunities’ is selected, then a new option will appear which 

will allow us to select the opportunities. 

 

We can assign this opportunity to a salesperson and his team. While creating the opportunities, 

it is optional for us to link it with a customer. If we select the option ‘Do not link with a customer’, 

then no customer will be linked with. There are other options available to link with existing 

customer or to create a new customer and link with him. 
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Or you can create opportunity directly 

 
 Sales -> My Pipeline -> Create

 

Note: - “Once a lead is converted to Opportunity it is pipelined” 

 

Sales Pipeline 

After creating the opportunities, it will be displayed in the Sales Pipeline section. From ‘My 

Pipeline’ menu, we can see that all the opportunities are grouped by their corresponding stages. 
 

 Sales -> My Pipeline 
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One of the main features of Odoo is the ‘Drag and drop’ facility in this view. We can change the 

status or stage of an opportunity by simply dragging from one stage to another. 
 

Pipeline Configurations 
 

We can configure the stages we want to use in our pipeline. Under the CRM module 

 Configuration -> Leads and Opportunities -> Stages

 

Here we need to provide a Stage Name, and Stage Probability to specify the probability of the 

lead when that lead is in this stage.

 We can relate this stage to a sales team if we need. If we select a team, then this 

stage will be accessible to those team members only.

 

Edit/Update Pipeline Content  

 Sales -> My Pipeline 
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 To create new opportunities, click ‘Create’ button. Edit an Existing opportunity select 

any of the opportunity from list.



 We can use the field ‘customer’ to select the customer related with this opportunity

 

Expected revenue from this Opportunity and probability of winning this Lead and converting it to 

our sales will also be shown here. Once we have set any Meetings related to this Opportunity, 

it can be seen by clicking on the button at the right top corner of this form. The number of 

meetings will be shown. In the Contact Information tab, the details of the contact related to 

this opportunity can be specified. The buttons, ‘Mark Won’ and ‘Mark Lost’ are used to mark 

the opportunity as won or lost. 

 

Next Activity field in Pipeline 
 

This another important settings available in Pipeline. At each stage of Pipeline we can assign next 

activity to be done for the follow up of that opportunity. To set next activity 

 Sales -> My Pipeline
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At the right bottom of every Lead, we can see a white dot symbol, which can be used to assign 

Next Activities to this opportunity. Upon clicking it, a new wizard will appear, which will allow us 

to create the next activity. 
 

 

The Next Activity can be Email, Call or Task. We should set a date and summary to specify the 

purpose of this activity. 

 

Note: - “you can track all the recorded ‘Next Activity’ from Sales -> Next Activities” 
 

 

Quotation 
 

Create Quotation 
 

Once the opportunity has been ‘Won’, next level is initiating actual sales procedure. So first step 

is preparing a quotation and send it to the customer. You can create a quotation by two methods. 
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 Sales -> Quotation -> Create
 

 

 The expiration date field is used to set the validity or expiration date of this quote. (If 

this field is not set, it will be automatically calculated based on the template associated 

with it if online quotation is installed.)

 The Payment Terms specify the conditions for paying an invoice.

(We can set it like, if the customers pays within 10 days, he will get 20% discount, etc.) 

 We can provide discounts to the order lines by enabling the option from the Settings.

 
 The 'Send By Email' button can be used to send this quotation to the customer by 

email.

 Under the ‘Other Information’ tab, we can provide the related salesperson and his 

team.

78



 

 

Or you can create a Quotation from your Pipeline. 

 

Once the opportunity is won (it reached its final confirmation stage), there is direct button to 

create Quotation for that opportunity. 

 

 Sales -> My Pipeline -> Won (or Whatever be the final Stage) Select any of the ‘Won’ 

opportunity
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 <New Quotation>

 

Sale Order & Invoicing 

Create Sale order 
 

As in the case of quotation we can create a sale order in two ways. 

 Sales -> Sales Orders -> Create
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Here we get a window to create a Quotation create Quotation and click Confirm Sale to create 

sale order. 

 Once the sale order is created you can access the same from inventory Module too.

 

Create Invoice 
 

Sales -> Invoicing -> Sales To Invoice 
 

Select the sale order to invoice. 
 

Just like the quotation, it is possible for us to specify the salesperson and the sales team related 

under the 'Other Information' tab. 

 The ‘Lock’ button is used to lock this sale order. Once it is locked, it cannot be edited. 

But we can deliver or create invoices for this order.

 The invoice status of this order will be shown under the Other Information tab.

 Click Create Invoice to generate invoice
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 The first option will invoice all the Invoiceable products in this order.

 Second option can be used to deduct the down payment and the other two are for 

providing down payment.

 If the user creating this invoice does not have access in the accounting section, he can 

just create the invoice. But he won’t be able to see or access it.

 

Reporting 
 

We can access several types of reports in Odoo. It is possible to analyze the Leads and 

Opportunities based on team, salesperson, state, etc. 

 Sales -> Reports
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Exapmle:- 
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Other Useful Settings 
 

Order Upsell 

 Sales -> Invoicing -> Orders to Upsell menu will list the orders having products with an 

invoicing policy based on ordered quantities for which you have delivered more than 

what have been ordered

 

Enable more than one address field for customer 
 

If we need to have three different addresses for customer, delivery and invoice, we need to 

enable this option from 

 Sales -> Configuration ->Settings -> Address

 

 
 

 

 

After enabling this option, we can see the new fields appeared for entering these addresses. 
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These addresses will be displayed in the reports also. 
 
 

 
 

 
 

Setting up margin for Sales 

 Sales -> Configuration ->Settings -> Margin
 

 
After it is enabled, we can see margin option in sale order. 

 

Setting Up Sales Pricelists 

To use different prices for products based on customers and other criteria, we can 

use pricelist 

 Sales -> Configuration -> Settings -> Pricing
 

 The first option will allow us to use a fixed price per product.

 Second option, we can set different prices for a product per each customer.

 Third can be used to create more advanced pricing rules.
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Define Next Activity 

 Sales -> Configuration -> Leads and Opportunities -> Activities -> Create
 

 
 Fill the fields and <Save>



Setup Delivery Method 

 Sales -> Configuration -> Delivery methods -> Create

 

 Fill the fields and <Save>

 Don’t forget to mark it Active and Publish on Website
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Purchase 

Just like the sales, it is really easy to manage our purchases using Odoo. We can generate 

quotations, convert them to purchase order and generate bills easily. After installing the 

Purchase Management module from the apps list, we can see the menu item 'Purchases' in our 

Odoo ERP. Sales and Purchase vouchers, Purchase and MRP management, Purchase requisitions 

etc. are some other helpful apps which can further enhance purchase management 

functionalities. 

As you all know Purchase is a process of buying goods, service, raw materials and spare parts 

from suppliers for an organization. Generally, purchase management is one of the most crucial 

section in an organization. The purchase process in a company should be given the maximum 

attention. If there is a problem in the purchasing department then problems will arise in the 

production section, Sales section and will ultimately reduce the performance of the 

organization. Hence an effective purchase management mechanism is inevitable in any 

organization. Odoo purchase management can improve your purchase workflow depending on 

stock levels, sales orders, and forecast manufacturing orders and so on. Here are some features 

of Odoo purchase management software 

Some of the useful features of Odoo Purchase management includes 

 Automate your purchasing workflow: Here we can automatically send RFQ s- (Request 

for Quotations) to your suppliers based on your stocks levels. This will improve your 

purchase and inventory performance along with procurement rules depending on stock 

levels, logistic rules, and sales orders, forecast manufacturing orders, etc. Select 

different refill scheme for each product depending on your manufacturing / delivering 

strategies. 

 Supplier price lists & product availability: We can easily make efficient purchase 

decisions using the best prices. With this, we can easily import suppliers' price lists and 

references to make quick and apt purchase decisions based on different vendor 

policies, quantities, and special contract conditions. We can easily track the availability 

of the product in your supplier’s inventory and you can also check your order status. 

 Get the best offer with purchase tenders:  Get the best price by bargaining / 

negotiating with different vendors. We can Launch purchase tenders and simply 

integrate vendor's answers in the process which help us to compare proposals from 

different vendors; Choose the best offer and send purchase orders within seconds. We 

can also use reporting to analyze the proposal of your vendors afterward. 
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 Get statistics on your purchases:  Analyze, forecast and efficiently plan your orders in 

simple steps. Get accurate statistics on your suppliers' performance through flexible 

reporting delivery delays, negotiated discounts on prices, quantities purchased, etc. 

Integrate purchases with analytic accounting to analyze your contracts' profitability. 

 Manage several companies: By using Odoo’s multi-company rules we can save time 

and effort. We can use a single Odoo instance to synchronize operations between 

different companies. By using this we can create sales orders, share customers, 

suppliers and products and invoice management for all companies at the same time. 

You can save even more time by automating the invoicing process between all the 

companies. 

 Fully integrated with other Odoo Apps: 

 

Inventory: Synchronize your stocks levels based on your purchases and create 

automatic replacement rules to avoid the out of stock situation 

Invoicing: Convert your purchase orders in a supplier invoice to avoid double entry. 

Accounting: Get your accounting more accurate by integrating purchase orders and 

invoices. 

 Control invoicing: Odoo ERP purchase module is integrated with inventory, invoice, 

accounting so you can make the process simple, and accurate.  

System Users 

There are three types of default user as far as CRM (Including Sales + Purchase + Customer 

Management) module is concerned. 

Manager: - Who will have complete access over all these Sales, Purchase modules 

User- Own documents only: - This user will have the permission to control the documents and 

entries created by him. For example, you can restrict a sales executive from accessing another 

sales executives documents. 

User- All documents: - for example, a Sales Head he has to view documents created by all sales 

executives. 
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Odoo Purchase management general workflow. 

 

A Request for Quotation (RfQ): is used when you plan to purchase some products and you would 

like to receive a quote for those products. In Odoo, the Request for Quotation is used to send 

your list of desired products to your supplier. Once your supplier has answered your request, you 

can choose to go ahead with the offer and purchase or to turn down the offer. 

 

A Purchase Tender (PT): also known as Call for Bids, is used to drive competition between several 

suppliers in order to get the best offer for a list of products. In comparison to the RfQ, a Purchase 

Tender is sent to multiple suppliers, stating each are competing with one another, and that the 

best offer will win. The main interest is that it usually leads to better offers. 

 

The Purchase Order (PO): is the actual order that you place to the supplier that you chose, either 

through a RfQ, a Purchase Tender, or simply when you already know which supplier to order 

from. 

 

Purchase process starts from the purchase order and ends with the reception of good/service. In 

Odoo you can either directly create a purchase order (PO) or you can request for a quotation and 

create PO only after verifying the quote by the vendor. You can choose to go for Purchase Tender 

in case of competitive bidding.  Anyway, every purchase will have a purchase order and the PO 

will generate an invoice, and depending on the contract with your supplier, you will be required 

to pay the invoice before or after delivery. 

 

Quotation and Purchase Order 
 
Request for Quotation 
 

The quotation contains the details of the products which we want to purchase from our 

suppliers. 
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 Purchase > Request for Quotation > Create

 Select the Supplier/Vendor.

 The order date will be filled automatically, when we create the document.

 The scheduled date in order line specifies that when should we 

receive the products.



Under Deliveries & invoices Tab you can find other important fields like 
 

Deliver To: Indicate delivery location (To know more about location refer inventory) 

 Click Confirm Order to create new Purchase Order
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Click the 'Receive Products' button, 

 For receiving the products, the user must be an Inventory Manager.

 The same process can be done via Inventory module too. All the Purchase orders 

will be listed in inventory section.

 You can view the Shipment status from “Shipments” button
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Vendor Bill 
 

To create a Bill corresponding to a sale order 

 Sales -> Control -> Vendor Bills -> Create

 

 Choose vendor and sale order from drop down list.

 The bill undergoes three stages namely ‘Draft’, ‘open’, ‘Paid’ for better control over the 

bill. Admin can set different user to validate those stages

 

Creating Backorder 
 

When we have fewer products to receive than the ordered, we can create backorders. In order 

to create a backorder, first, we have to sign in as an inventory user. 

 Purchase -> Purchase order

 Select your purchase from list and Click <Shipment> button

 Click <Edit>
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 In the 'Done' column, we can enter the number of products which we need to receive 

this time. If you enter less number of products than in the form then a wizard will 

appear asking you to confirm creating the backorder.
 
 

 

Purchase Analysis 
 

Just like in the sales there are several analysis tools available in purchase module. Under the 

Reports menu, we can analyze the purchase and suppliers. 
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Vendor management 
 

Since Odoo sales and Purchase module  is  associated  with  CRM,  there  is  no  separate  vendor 

management in purchase,  rather  it  access  Partner management  subsystem  just  like in the 

Sales module. Using this module we can add persons or entities to our system who can act either 

as Customer or Vendor or Both. In purchase module we can access this module under Purchase 

> Vendor tab. 

To see detailed vendor/Partner management operations, Refer CRM module. 
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Product Management 
 

To Purchase any product, we must create a product in our system. Though it is an activity done 

under inventory management, Oddo Purchase module provide a quick link under Purchase > 

Products tab to perform product management functions like Add Product Update Stock etc. To 

see the full functionality and processes in Product Management refer Inventory management 

module. 

 

Other Useful configurations 

Purchase Tenders 
 

The purchase tender or call for bids facility can be used in situations where we have a list of 

products to buy and multiple suppliers for that products. By using purchase tenders, we can get 

the best offer for the products. We will send the purchase tender to multiple suppliers and they 

will compete with each other and best offer will win. We will get the best offer. For enabling 

purchase tenders, go to 

 Purchase -> Settings

 

 

 Select the call for tender’s option.

 

After this option is enabled, we can see two new menu items, 

'Purchase Agreement Types' and 'Purchase Agreements'. 

The purchase agreement type menu can be used to create the agreement types.

95



 

 

Create Purchase Tender 

 Purchase -> Purchase Agreements -> Create

 

 In the Responsible field, specify the person responsible for this tender.

 The Agreement Deadline field, select the date to bids are closed for suppliers.

 In the Ordering Date field, select the date to which you will place the order.

Add the products and the quantity 

Now we can see some buttons appeared, new quotation, validate and RFQ/Orders. 
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 Clicking on New Quotation will redirect us to the quotation creation form.

 Once we validate the tender, it will go to the stage ‘Bid Selection’. Go to the RFQ which 

we want to proceed with and confirm the order.

 Now go back to the tender and close the tender by clicking on the button ‘Done’.

 

Purchase Approval 
 

This feature allows us to set multiple levels of approval for the purchase orders. If this feature 

is enabled, for every purchase order the user creates, approval from the manager is required to 

confirm the order. If the user creates a quotation and confirms it, it will go to a waiting approval 

state. The purchase manager can then approve or reject it. 
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Inventory Management 
 

Inventory is the heart of the business, it is from here all other parts of the business get sufficient 

energy to live. If properly managed, the business remains healthy, otherwise always messy. Odoo 

inventory management is a resourceful module which can be utilized by any business 

organization irrespective of their size. It is designed in such a flexible manner. Odoo inventory is 

fully integrated with other applications, such as Purchase, Sales or Inventory. But is not limited 

to those processes, it is also fully integrated with our e-Commerce, Manufacturing and Repairs 

applications [8]. To Access inventory and warehouse management module in your ERP, you have 

to install ‘Inventory Management’ app from Odoo. 

 

Odoo inventory management makes a worthy product to use because of the following features. 

 Clean and Fast 

Odoo Double entry inventory management, flexible design, modern user interface, mobile 

control and tracking mechanisms make Odoo a clean and fast performing ERP. 

 

 Basic operation support 

Prepare delivery order in simple steps, control and manage incoming shipments, prepare 

inventory counts (cycle counts), multiple location management, barcode-based packing, 

efficient scrap management, stock transfer option etc. Odoo support all the basic and 

advanced operations takes place in a warehouse. 

 

 Advanced Routing 

Odoo advanced routing support operations like 

Drop-shipping  

Deliver to customers straight from your supplier based on products, orders or customers.  

Cross-Docking  

Unload incoming material and directly transfer to outbound gates with little to no storage 

in between.  

Put away & Removal strategies  

Define your own storage and removal strategies; FIFO, nearest available zone, LIFO, etc.  

Pick - Pack - Ship  

Design your own order process flow. Deliver to customers in one step (delivery order) or 

several steps: picking, packing, and shipping.  

Push & Pull Routes  

Design your own product routes to automate transfer orders between warehouses or 

locations.  
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Multi-Warehouses  

Manage all your warehouses with the same system and define replenishment rules 

between warehouses. 

 

 Replenishments 

To keep your inventory properly replenished, Odoo provides options like 

Minimum Stock  

Have proposition of purchase orders (or request for quotations) created by Odoo based 

on your future stock forecast.  

Purchase Propositions  

Get purchase order propositions based on supplier lead times, product demand and 

inventory forecasts.  

Make-to-Order  

Purchase raw materials or manufacture products to order. Define your own routes specific 

to warehouses, products, orders, etc.  

Request for Quotations  

Want to negotiate a price with suppliers every time you buy a specific product? Odoo can 

trigger request for quotations automatically based on future needs. 
 

 Traceability 

Tracking your product inside and outside the inventory is a challenging task. But Odoo 

traceability features like ‘Lots Tracking’, ‘Activity Log’, ‘Serial Numbers’, ‘Perpetual valuation’  

make it easier for you.  
 

 Product Management Features 

Product Types  

Odoo supports several product types that have different behavior: physical products, 

consumables, services, digital products.  

Kits  

Odoo's kitting features allows your salesperson to sell a kit, but you will deliver a set of 

products. 

Custom fields 

Add as many custom fields as you want on products to handle your business needs. 

Multi-Level Variants 

Define multiple level variants in just a few clicks. Create matrix based on colors, sizes, 

attributes, etc. 

Multiple unit of measures 

Odoo supports multiple unit of measures and converts automatically for you: buy a pallet 

of beer, sell packs of beers. 
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Expiration Dates 

Track expiration dates on products. 

Multiple barcodes 

Create custom barcodes with specific codes to implement desired behaviors, such as a 

specific promotion. 

 

 Business intelligence 

The capability of Odoo BI and reporting tools are already explained in many modules. Odoo 

BI tools perform similar admirable  jobs here in Manufacturing module by providing reports 

like inventory forecast, customer transaction drilldown reports, perpetual inventory 

valuation reports etc. [9] 

 

If we compare Odoo Inventory with proprietary ERP Microsoft Dynamics, we can that find 

many features like Freight Carrier Integration, Consignee stock management, etc. are not 

available there. And if the comparison is between SAP and Odoo, Odoo has the advantage of 

features like multiple variant support, Up and Down traceability, more effective barcode 

support etc.[10] 

 

Before going to the detailed operations of Odoo inventory management, let’s first explore 

some of the terms used in the modules. It will give you a better understanding about working 

Odoo Inventory management system. 
 

Warehouse: A warehouse in Odoo is a location where you store products. It is either a physical 

or a virtual warehouse. It could be a store or a repository. 

 

Location: Locations are used to structure storage zones within a warehouse. In addition to 

internal locations (your warehouse), Odoo has locations for suppliers, customers, inventory loss 

counter-parts, etc. 

 

Lots: Lots are a batch of products identified with a unique barcode or serial number. All items of 

a lot are from the same product. (E.g. a set of 24 bottle) Usually, lots come from manufacturing 

order batches or procurements. 

 

Serial Number: A serial number is a unique identifier of a specific product. Technically, serial 

numbers are similar to having a lot of 1 unique item. 

 

Unit of Measure: Define how the quantity of products is expressed. Meters, Pounds, Pack of 24, 

Kilograms etc. Unit of measure of the same category (ex: size) can be converted to each other’s 

(m, cm, mm) using a fixed ratio. 
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Consumable: A product for which you do not want to manage the inventory level (no quantity 

on hand or forecasted) but that you can receive and deliver. When this product is needed Odoo 

suppose that you always have enough stock. 

 

Stockable: A product for which you want to manage the inventory level. 

 

Package: A package contains several products (identified by their serial number/lots or not). 

Example: a box containing knives and forks. 

 

Procurement: A procurement is a request for a specific quantity of products to a specific location. 

Procurement are automatically triggered by other documents: Sale orders, Minimum Stock Rules, 

and Procurement rules. You can trigger the procurement manually. When procurements are 

triggered automatically, you should always pay attention for the exceptions (e.g. a product 

should be purchased from a vendor, but no supplier is defined). 

 

Routes: Routes define paths the product must follow. Routes may be applicable or not, 

depending on the products, sales order lines, warehouse, etc. To fulfill a procurement, the system 

will search for rules belonging to routes that are defined in the related product/sale order. 

 

Push Rules: Push rules trigger when products enter a specific location. They automatically move 

the product to a new location. Whether a push rule can be used depends on applicable routes. 

 

Procurement Rules or Pull Rules: Procurement rules describe how procurements on specific 

locations should be fulfilled e.g.: where the product should come from (source location), whether 

the procurement is MTO or MTS etc. 

 

Procurement Group: Routes and rules define inventory moves. For every rule, a document type 

is provided: Picking, Packing, Delivery Order, Purchase Order etc. Moves are grouped within the 

same document type if their procurement group and locations are the same. 

 

Stock Moves: Stock moves represent the transit of goods and materials between locations. 

 

Quantity On Hand: The quantity of a specific product that is currently in a warehouse or location. 

 

Forecasted Quantity: The quantity of products you can sell for a specific warehouse or location. 

It is defined as the Quantity on Hand - Future Delivery Orders + Future incoming shipments + 

Future manufactured units. 
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Reordering Rules: It defines the conditions for Odoo to automatically trigger a request for 

procurement (buying at a supplier or launching a manufacturing order). It is triggered when the 

forecasted quantity meets the minimum stock rule. 

 

Cross-Dock: Cross-docking is a practice in the logistics of unloading materials from an incoming 

semi-trailer truck or railroad car and loading these materials directly into outbound trucks, 

trailers, or rail cars, with no storage in between. (Does not go to the stock, directly from incoming 

to packing zone) 

 

Drop-Shipping: move products from the vendor/manufacturer directly to the customer (could 

be retailer or consumer) without going through the usual distribution channels. Products are sent 

directly from the vendor to the customer, without passing through your own warehouse. 

Removal Strategies: the strategy to use to select which product to pick for a specific operation. 

Example: FIFO, LIFO, FEFO. 

 

Put away Strategies: the strategy to use to decide in which location a specific product should be 

set when arriving somewhere. (Example: cables goes in rack 3, storage A) 

 

Scrap: A product that is broken or outdated. Scrapping a product removes it from the stock. [11] 

 

Product variant: Basically, we have two methods to add a product. Product with “Variant” option 

and standalone product. For example, if you want to add two products say iPhone 7 black, 

iPhone7 white, to your system. Here you may add two different products or two variants under 

a single product. Definitely later is the convenient method. To enable this feature, see the topic 

configurations. 
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Manage Product 
 

 Inventory > Inventory control > Product > Create
 

 

All the fields under this form is very important 

 Can be sold -> Tick this and the product will be listed in sales 

 Can be Purchased -> tick this and the product will be listed in purchase 

 Can be Expensed -> if the product is for Internal usage 

 Product type -> whether the product is Stackable, Consumable, or Service 

Fields Under inventory Tab 
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 Routes: - The way which your company acquire this product. 

 Vendor: - Under this section you can add the Vendors (suppliers) of this 

product 

 Tracking: - internal tracking mechanism, either via Lot no or via Serial number 

 

 

Fields under Sales Tab 
 

Website Categories: - here you can specify the category under which the product should be 

displayed in E-commerce website 

Alternative/Accessory Product: - associated product to list in Website 

 

Under product Variant tab, as we mentioned earlier, you can add variants of this Products.

 Click <Add an Item>

 add an Attribute for ex: color

 then add attribute Values

Based on the Attributes and values you provided, system will generate all combinations of 

variations under “Variants Button”. 
 

 

Like this 
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 You may delete any variant you don’t have.

 Follow Variant Price tab to adjust prices of all variants

 

Note: - You can update inventory attributes like Quantity in Hand and Procurement request 

etc. from the same window 

 

Note: - You can Update/Delete a product information from same menu i.e. Inventory > Inventory 

control > Product 

 

 

General Configurations 

 Inventory> Configuration> Settings> Products
 

 

 Unit of Measure: By ticking the second option you can Sale/Purchase products 

in a different unit of measure. For example, you may buy Bottle as a dozen and 

sell it individually. 

 

 Product Variant: - Tick here to include product variance  in inventory. 
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 Inventory> Configuration> Settings> Traceability
 

 Lots and Serial Numbers: - This field specify how you track your item in inventory. 

 

 Inventory> Configuration> Settings> Location and Warehouse
 

 Procurement:  -  choose  the  method  to  Reserve  a  product,  after  a  sale 

order  is confirmed. In second option you can set a scheduler to reserve product 

 Warehouses and Location level: - Choose according to your usage level 

 Routes: - Choose advanced routing, if your procurement contain more than 

one step 

 Drop shipping: - this allows you to configure different delivery option for your 

suppliers. 
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Dashboard 

Dashboard give a glimpse to all the operations in your Warehouses. 
 

 Click <More> to view all the operations in the warehouse

Inventory -> Operations -> All Transfers 
 

 You can see all confirmed Sales and Purchase orders listed here.

 You can click and view the status of each one.
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Warehouse Configuration 

You can add any number of warehouses under your company. As we mentioned earlier we can 

have multiple ware houses. 

 Inventory > Configuration > Warehouse Management >Warehouses -> Create

 

Choose Incoming Shipment and Outgoing Shipment settings, you can choose any of your existing 

warehouses for Resupply. <Save> it and <Activate> it. 

Note: - you can Update/Delete this Warehouse details from same menu i.e. Inventory > 

Configuration > Warehouse Management >Warehouses. 
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Locations 

Locations are different places in your ware house. Or these are the different sections in your 

ware house were different types of actions are done. You can add single or multiple locations. 

A location means a space in the warehouse, a shelf, a floor, etc. A location is part of one 

warehouse and it is not possible to link to another warehouse. Actually all In and Out 

transactions are carried out and Recorded through Locations. (If you look into Purchase order, 

you can see Deliver to option, which essentially indicate a location) 

There are three types of location 

 Physical Location

These are Locations in your warehouse 

 Partner Location

This location not under your warehouse 

 Virtual Location

This is a virtual location which is not available physically 

 

You can view all the locations available under you company from 

 Inventory -> Configurations -> Locations
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Create a Location 

 Inventory > Configurations > Locations > Create

 
 

 Parent location: - in case you are creating a location under another location 

(location hierarchy) 

 Owner: - Choose a user to manage it 

 

 Fill all other necessary fields and click <Active> and <Save>

Note: you can Update/delete a Location information from the same menu. 

 

Operations 

Operation means, different operations carried out in your ware house like Receipts, Internal 

Transfer, and Delivery Order. These are basic operations carried out in a warehouse. However, 

you can add more custom operations from 
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 Inventory -> Configuration -> warehouse management -> Operation Types -> Create

 
 

 Fill the operation details and click <Activate> and <Save> now these operation will be 

listed in your Dashboard.



Routes 
 

it is the different possible ways through which a product is acquired or sold from your ware 

house. You can simply follow single step process (like vendor's warehouse to your warehouse) 

or can configure multiple step routs. You can see a field asking the Rout while creating a Product. 

Rout ensures a sale or purchase product is properly tracked. 

 

You can view all the Routes from 

 

 Inventory > Configuration > Routes

 

 

 

111



 

 

You may define new Rout rules from 

 Inventory > Configuration > Routes > Create

 

 Tick Product categories to view the Rule in Product category also

 Choose the Ware house

 Click Add an Item to add new Rule.
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Here the Action Indicate exact physical action done. (In this picture it is, 'Move from Another 

Location', consequently you have to fill source and destination Locations.) 

Or you can choose Buy 
 

 Save the Rule and add another Rule if needed. Otherwise click <active> and <save> 

Route.

 

Unit of Measure 

Different products have different unit of measure. You can Configure all these unit of measures 

to you inventory. 

 Inventory > Configurations > Unit of Measure > Create
 

 Unit of Measure: - Name of UM 

 Category: - you may add new category or select from an existing one. 
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 Type: - here you have three options; 

Reference Unit- Means, this will be the base unit for all units in this 

category (for example we can set Meter as base for length category.) 

Bigger than reference unit- Example, if meter is reference unit the while 

you add KM you must choose this option 

Smaller than reference unit- opposite of the above 

 Ratio: - ratio between Reference unit and other unit 

 

 

Reordering Rules 

You can create a custom Rule to replenish your Inventory automatically. For example, if you 

wish to re-order a product when the stock reaches 10 units. You can set a Rule, and when you 

Run Scheduler system will check this Rule and take appropriate action automatically. 

 Inventory > Inventory Control > Reordering Rules > Create
 

 Minimum Quality: - minimum number of quantity should be kept in inventory 

 Maximum Quantity: - Quantity upper limit 

 Quantity Multiple:- Lowest number of items can be ordered at once 

 Procurement Group: - Set procurement and Picking option 
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 Activate and Save the Rule.

 

Inventory Update 
 

You can update stock details in two ways, first one is via going to product details and update 

individually. You can update multiple product details also. 

 Inventory > Inventory Adjustments > Create
 

 Give a Name, select the required products and click Start Inventory
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 You can change the stock details by clicking over the product quantity.

 Commits the changes and  click <Validate>



Scrap 

To record the scrap products in your inventory. 

 Inventory > Inventory Control > Scrap > Create
 

 Fill the Scrap product details and Save
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Scheduler 

Run Scheduler will check all the Reordering Rules you created and make appropriate action. 

 Scheduler > Run Scheduler
 

 Click Run Scheduler



Reports 

Odoo inventory management system provides the user very effective and simple reports to make 

more wise decisions. You can access reports from 

 Inventory->Reports
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Manufacturing 
 

Manufacturing is a process of converting raw materials or components into finished goods or 

products. For a company which handle large quantity of manufacturing products have to track 

every manufacturing orders efficiently. The Manufacturing Module in Odoo help you to handle 

the complexity of Production, Manage Bills of Materials, Plan Manufacturing Orders, and Track 

Work Orders etc. Manufacturing module is one of the basic application in Odoo. You have to 

install ‘Manufacturing’ app from Odoo Apps to avail this module on your ERP. Since the 

Manufacturing module is highly integrated with Inventory Management, you can keep your 

inventory automatically updated with each manufacturing process. 

 

Working methodology is very simple in Odoo manufacturing. You can create a Manufacturing 

Order of a product and pass it through your different stages in production line and complete 

production. You may customize manufacturing procedure matching your company’s process 

using WorkCentre and routing concepts. You can easily manage ‘Scraps’ during any stage of 

manufacturing procedure and ‘Unbuild’ a manufactured product if needed. Organization may 

assign different level users to overlook the entire manufacturing procedure for effective 

management of entire process. 

 

If we compare Odoo manufacturing module with other ERP solution, like in all other modules 

we can find lot of unique feature which Odoo alone have. For example, features like byproducts, 

routing facility, single BOM for multiple product variant, MRP II scheduler, Master production 

scheduler, Kanban Planning, Production calendar, backward scheduling, Work orders, Repair 

etc. Are not available in SAP ERP while Odoo implement all of them.  And against Microsoft 

Dynamics, Odoo have the advantage of features like Equipment / Machine Management, Work 

Instructions on Work Orders, Maintenance Requests from Shop Floor Terminal, Production 

calendar etc. [12] 

 

Following features [13] make Odoo manufacturing module an efficient one. 

 Manage 

Manufacturing orders 

Manage your products into assembly lines or manual assembly. 

Work orders 

Launch production of items needed in the final assembly of your products. 

Repair orders 

Manage repairs of items under warranty or as a service. 
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 Schedule & plan 

Plan manufacturing 

Get a clear view on your whole planning and easily reschedule manufacturing. 

Organize work orders 

Have access to all available resources and plan ahead with your production. 

Manage Bill of Materials 

Keep track of availability of items in stock and production time. 

WorkCentre Capacity 

MRP II scheduler using capacities and schedules of WorkCentre. 

 

 Define Flexible Master Data  

Create multi-level Bills of Materials 

Set a Bill of Materials within another in order to manufacture components of a product 

in another Bill of Materials. 

Optional routing 

Create new routings for work orders in order to sequence your production depending 

on the routing used. 

Version changes 

Allow your products to evolve and add configurable options when creating orders. 

Phantom of Bill of Materials 

Create phantom BoM to manufacture and sell products in kits or to build replacement 

parts.  

 Quality 

Control Points 

Automatically trigger quality checks for the manufacturing department. 

Quality Checks 

Deploy your statistical process control easily with checks. 

Quality Alerts 

Organize your work using the Kanban view of quality alerts. 

 Maintenance 

Preventive Maintenance 

Trigger maintenance requests automatically based on KPIs. 

Corrective Maintenance 

Trigger corrective maintenance directly from the control center panel. 

Calendar 

Schedule maintenance operations with a calendar. 
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Statistics 

Get all maintenance statistics computed for you: MTBF 

 WorkCentre Control Panel 

Tablets 

Set tablets on every work center to organize their work efficiently. 

Record production 

Register productions, scan products, lots or serial numbers. 

Worksheets 

Display worksheets directly on the WorkCentre with instructions for operator. 

Misc. Operations 

Scrap products, create quality alerts, and perform checks, right from the WorkCentre. 

Alerts 

Use alerts to show changes or quality checks to the operator. [13] 

 Business Intelligence 

Get detailed analysis report on your production line, analyze the performance of your work 

centers and production, plan alternative production strategies etc. are some of the 

qualitative measures Odoo BI engine can suggest to you in manufacturing module. 

 

System Users  

By default there are two types of user in manufacturing modules. 

 Manager: - He is the one who manages everything, including Crete BOM, Work Order, 
Routing procedure etc. 

 User: - Generally he can create a manufacturing order and process it. But manager can 
grant more permission to this user if needed. 

 
 

Manufacturing Order Management 
 

There are two ways we can produce a product with Odoo manufacturing App. We can create a 

manufacturing order with simple default stages and complete the production. Or we can 

customize our work order by setting up work center and routing mechanisms. 
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Create a Manufacturing Order (Simple Method) 

 Manufacturing  > Operations > Manufacturing Orders > Create 
 

 

 Choose a product from list (or you may create new one)

 Choose Bill of Material

 Finished product tab will show you the number of finished products.

 Consumed Material tab will display the material consumed for the production 

 Click “Check availability” to see the availability of raw materials in inventory.

 
Manage Production 
 

Once you have created and confirmed a Manufacturing order, you can start production. Odoo 

will list all the Manufacturing orders under Manufacturing -> Operations -> Manufacturing 

Orders.  You can view the status of all ongoing manufacturing order from here. 
 

Select a Manufacturing Order from list. 
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 Since Odoo support negative inventory support you can start production even 

without ensuring the raw material availability.

 Click “Produce” to start production.

Once you start production the status bar will change as follows 
 

 “Mark as Done” to complete the production process

 “Post inventory” to update inventory movements.

Note: - You can “unreserve” any raw material from manufacturing order to make it available to 

inventory, Click “Unreserve” button on progress Tab to take this action. 

Note: - you can Update/Delete any manufacturing order from Manufacturing -> Operations -> 

Manufacturing Orders Tab. 

 

Create a Manufacturing Order (Advanced Method) 
 

Comparing to simple method, advanced method provide each company to configure more 

detailed manufacturing process such as setting up Work Centers, Routing, Work Order 

management etc. 
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To enable this feature 

 Manufacturing -> Settings -> Manufacturing Order



 
 

 Enable ‘Manage Production By Work Orders’

This will enable new menu in dashboard to manage Work Center, Routing and Work Order. 

 Manufacturing - > Operations -> Manufacturing Order -> Create
 

 Fill the fields same as before.

 Select a ‘Routing’ mechanism, this will be automatically filled once you choose the BoM.
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The Status bar will give you a new option Create Work Order, Click it to create the work order 

according to your routing plan 

 In new Window you will have an option to Check Availability of raw material. (Odoo 

support negative inventory)

 Click <Save>

 Unlike in simple method now you just created a Work Order, the production process 

has not started yet. 



Manage Production 
 

To Start Production you have two option either 

 Open a manufacturing order and Click “Work Order” button in the form.

 
 



 Or you can access all your work orders from “Manufacturing > Operations > Work 

Order”
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 In the first Case you will see all the work orders listed there with their status.

 

 Select the Tasks from Work Order one by one and complete it.
 

 

 Use ‘Pause’, ‘Block’, ‘Done’ Buttons to control the progress of Task.

 Done means the Task is completed or the Task Status changes to Finished and you can 

automatically move to next Task in the Work Order.
 

 Complete all the processes in the Work Order to complete Production
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 Once you complete all the process in Work order then you can add the product into the 

inventory

 

Bill of Materials 
 

BoM is the basic building block of any manufacturing process. It is the list of raw material needed 

to produce a product. So while creating a manufacturing order for a particular product we need 

to select corresponding BoM from the list. BoM will help us to create the inventory updated 

during manufacturing process. So before creating BoM we first need to add the Raw material to 

our product list in inventory. 

 Manufacturing > Master Data > Bill of Materials > Create
 

 Select a product from list.

 Go to Settings -> Manufacturing Order -> Product variant option to enable select 

product variant option. (In case you produce a product Variant)

 Reference field is used to distinguish Different BoM for same product.

 Click Add an Item field and add the raw materials for your product.

 “Routing”, field is used to specify the WorkCentre routing of manufacturing process.

 Under the Miscellaneous tab in BoM, Sequence defines the order in which your BoMs 

will be selected for production orders, with lower numbers having higher priority.

Note: - A BoM can be later Updated/Deleted from same menu i.e.    Manufacturing > Master 

Data > Bill of Materials. 
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Work center 
 

As the name indicates, it is the Physical place in your firm where different manufacturing 

processes are done. You can create you work center details with all its performance indices. 

Later you can use this data to analyze the efficiency and other details of each work center. 

Create Work Center 

 Manufacturing -> Master Data -> Work Centers ->Create
 

 

 Add all the necessary information including the process done here and the 

performance factors etc. in field

 Click <save> and mark <Active> to make it available for use.



Note: -“you can update/ Delete any work center information from same menu i.e. Manufacturing 

> Master Data > Work Centers >” 
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Routing 
 

Each product have its own routes. Manufacturing process is not a single step process it may 

contain many Work Centers and each work centers have its own processes and process time. 

From this menu, we can set the order or route of each manufacturing. It’s purely depends on 

the manufacturing company process. Some company has same type of  manufacturing  process. 

Then we create one routing. Some company has different manufacturing process for different 

products. Then we create each multiple routing. 

 Manufacturing > Master Data > Routings > Create
 

 Give Rout a Name

 Click Add an Item to add the work centers included in this rout

 Click <save> and <Mark Active>

 

Note: - “You can Update/Delete a routing process from same menu i.e. Manufacturing > Master 

Data > Routings” 

 

Work Order 
 

Once you have created and confirmed Manufacturing Order with a specific Rout. All the 

processes in the Rout are listed as work orders. So in order to complete a production, we must 

complete all the associated processes in work order. We can access Work Order related to a 

Manufacturing Order, either from Manufacture Order form or directly from Manufacturing > 

Operations > Work Orders 
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Scrap 
 

One of the most useful features of Odoo is that you can create Scrap at any stage of production 

line. You can always see a Scrap button almost all the stages of the production line. Click this 

button to create instant scrap entry in inventory. You can create fresh scrap entry from 

 Manufacturing -> Operations -> Scrap -> Create

Or you can make a quick entry by clicking on Scrap button available on almost all forms of 

production. 
 

 

 Fill the fields and Click “Done”. It will automatically inserted into the  inventory.

 

Unbuild Orders 
 

Another useful feature in Manufacturing is Unbuild. We can unbuild the products into its bill of 

materials. This is actually a reverse process of production. 

 Manufacturing > Operations > Unbuild Orders > Create 
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 Select the product which need to Unbuild,

 Select the bill of materials and quantity.

 If you need to specify a particular Manufacturing Order we can mention it here.

 Click <Done> and <Save>



Reporting 

Odoo Reporting tools can produce concise yet very effective reports. You can view different types 

of report on Manufacturing Orders, Work orders, Work center Performance etc. under Reports 

tab 

 

Configurations and Useful Settings 

Byproducts configurations 
 

A by-product is a secondary product derived from a manufacturing process. It is not the primary product 

or service being produced. To activate by product feature 

 Manufacturing > Settings
 

Tick the second option to enable By Products field in BoM. After ticking this we can see an additional 

tab in the BOM form after the miscellaneous. 
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 Here we can add byproducts

 If we add the byproducts it will reflect on the MRP order.
 
 

  

131



 

 

Human Resource 
 

Odoo human resource management module is a comprehensive package to meet all your HR-

related needs. It can manage the functions from Recruiting to, Employee Information 

Management, to Attendance and Leave management, Payroll, Expense, and Timesheet 

management.  You have to install following apps from Odoo apps to enable HR management 

features. 

Employee Directory 

This application allows you to create and manage the employee directory of your organization. 

You can create your organization's department hierarchy and add employees under different 

department matching your organization’s structure. Employee contract details are configured 

using this module. So this is the base of HR module. 

 

Attendance 

Employee attendance can be managed by installing this module. There are different attendance 

marking options available with Odoo. You can also add hardware for attendance marking. The 

module is integrated with Payroll, Leave Management, and Timesheet so that it provides a 

consistent attendance tracking mechanism.   

 

Leave Management 

Integrated with attendance, Payroll, and Timesheet, Leave Management allows the 

administrator to take efficient decisions on employee leave request. 

 

Payroll 

Odoo Payroll makes the complexity of payroll management simpler. You can create simple and 

complex salary structure based on salary rules. This salary structure can be applied to employee 

contract to generate monthly payment slip. From Odoo store you can also download custom 

payrolls for easy management. 

 

Expense Management 

Expense management module enables management of expenses occurred to employees. The 

employee can submit their expenses and appropriate officers can take actions on such requests. 

 

Timesheet Management 

It is another efficient module to manage timesheets of each employee. This is generally used for 

efficient management of projects or tasks. 
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Recruitment 

You can automate and monitor all recruitment with this module. Recruitment stages, criteria, 

qualifications etc. can be configured with this module. You can install Online Jobs app to 

channelize recruitment via your website. 

There are some more other useful apps and plugins that you can find in Odoo App store. 

 

Some of the features [14] of the Odoo HRM module is  

 

 Manage 

Create employee profiles 

Gather all information concerning each employee at one place. 

 

Manage contracts 

Keep track of your employees’ status, job titles, contract type and dates, and their 

schedule. 

 

Manage timesheets 

Create weekly and monthly timesheets and follow the time spent by your employees 

on projects. 

 

Handle attendance 

Keep the track of your employees’ presence at work. HR managers can easily report 

employees' monthly presence with the menu entry and state. 

 

Manage leaves 

Manage holidays, legal leaves and sick days. 

 

Dashboards 

Get a dashboard per manager. 

 Collaborate 

Enterprise social network 

Follow employees and documents, join discussion groups, share files, and chat in real 

time. 

Gamification 

Design challenges, goals and rewards with clear targets and objectives to drive 

engagement and reward your employees’ performance. [14] 
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System Users:- 

Basically there are three types of users in HR management process 

Employee: - Normal employee of office. He can mark his attendance, access the tasks assigned 

to him, manage his timesheet and perform other tasks associated with him. 

 

Officer:- A higher level employee who has better powers and access rights like sanction leave, 

sanction time sheet etc. 

 

Manager: - Manager who control and configure every procedure in HR module. Complete control 

over all level. 
 

 

Department Management 
 

Create and manage your organizations departmental hierarchy easily with Odoo HR module. 

Create department 

 Employee > department > Create
 

Fill all necessary fields and click <save> 

Note: - “to create a sub department choose the parent department from 
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dropdown” Note: - “mark it as Active, then only the created department will be 

available to use” 

 

Delete/Update department 
 
Employee > department

 Click on <more> option from your respective department
 

 

 Choose <Settings> from the option and make the changes you need

 
View Employees in the department 

 Employees > Department
 

Click on <Employees> button on respective department to view employees of that department 
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Department wise Report 

 Employee -> department

 Click on <more> option from your respective department

 
 

You can click on any of the reports to view in detail 
 

Employee profile management 
 

Create an Employee Profile 

 Employees > Create
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You can Jump through “Public information”, “personal information”, HR settings” tabs to find all 

the necessary information for an employee. 

 Click <Save>

 

Update/Delete an employee 

 Employees > Dashboard

 Select any of the employee from the list.



 You can view employee info on the window, make necessary changes if needed and 

save

 To delete an employee click on ‘Action’ > Delete



Note: - “In HR Tab there is field “Related User”, using this option you can assign an employee 

to any ‘system user’. For example, project manager can be any employee of the firm as well as 

he can be the “Administrator” of the system” 
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Contract management 
 

Add new contract 

 Employees > Contract > Create
 

You can select ‘Employee’ ‘Department’ and other basic information from the window and assign 

the contract directly to an employee. 
 

Working Schedule:- 

We can set working schedule of the Employee from here itself. Click working Schedule Drop 

Down menu to add working schedule of the employee. 

 

 

 Click Add an Item to Fill duty timing and Leaves

 Click <Save>
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Update/Delete a contract 

Admin can Update a contract information, contract Status or delete a contract altogether by 

following method 
 

Employees > Contract
 

Select the contract you wish to change 

 

 
 

 Make edits wherever needed and click <Save>

Note: “change the status of the contract by just clicking on ribbon that indicate the status” 
 
 

 

Leave Management 
 

Leave management in Odoo is done through two phase at first phase employee request for 

leave and the HR manager or concerned level officer must sanction the leave. Oddo generates 

detailed report to analyses the leave behavior. Admin or concerned officer can view these 

reports before sanctioning leave to an employee. 
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Making Leave Request 

 Leaves > My Leaves > Leave Summary > Create



 

 Fill the fields and <save>

(Now the status of your leave is “To Approve”, it will be changed once concerned officer approve 

this leave). 

 

Approve leave 

Once a user make a leave request, the concerned officer like HR admin must approve the same 

to sanction leave. 

 Login as Administrator

Leaves > Leaves to Approve

 All leave requests will be listed here

 Select a leave request and Approve or Reject
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Leave Report 

Administrator can View detailed and varying reports in his dashboard. 

 Leaves> Reports
 

 
Leave Allocation 

Unlike leave request, leave allocation is more planned leave request employee can request to 

allocate leave for him (generally in case of long leaves). Leave allocation option in Odoo leave 

management gives an easy interface to accomplish this task. 

 Leaves > My leaves > Allocation Request >  Create
 

Fill the fields and click <Save> to submit the leave to manager for approval 
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Attendance Management 
 

Odoo HR management includes attendance module which manages employee's attendance. 

Attendances are recorded according to the Check in/ Check Out actions. After installing 

attendance module from Odoo apps, we can see a new menu named Attendances. 

 

Attendance Entry 

Basically there are three ways to mark attendance 

 

 Direct login and mark attendance 

 Admin Make manual check in and check out entry 

 Kiosk Mode 

  

Direct login and mark attendance 
 

Since system login credentials are generally available to officer level employees this attendance 

marking facility is available only for those  employees  who  have  a  system  login  Username 

and Password. They can login to the system and mark their attendance from Attendance menu. 

Login > Attendance 
 

Click the image to check in and click again to check out. 
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Admin make manual entry 
 

Since direct login is not allowed for all users, Oddo provides another option to mark attendance. 

Administrator or any dedicated person can mark attendance for each employee. 

 

 Attendances -> Manage Attendances ->Attendances -> Create

 

 Mark the fields and <Save>

 

Kiosk Mode 

 

New Interface provided by Odoo version 10, which feeds attendances of employee using their 

badges or pin. The badges can print from employee form. 
 

Using these badges employees can Check In/out. 
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 Attendances -> Manage Attendances -> Kiosk Mode

 

Another option is Check in/out using pin. For this we have to enable Configurations under 

Attendance menu. 

 

Use “Select Employee” button on kiosk mode to check in/out using pin. It gives the interface to 

enter pin. 
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Reports 

Admin can view detailed attendance report on 

Attendances > Report 

 

 

PayRoll 
 

To enable the payroll functionalities we have to install a new plugin in HR, called Payroll. To 

integrate payroll with accounting, you have to install another plugin that is Payroll Accounting 

from Odoo apps. To generate a pay slip, the employee should have an active contract and a 

salary structure. Salary structures are created using different salary rules of different 

categories. 

 

Salary Rule 

Salary rules are the basic blocs for calculating an employee’s salary. It specifies how to calculate 

DA, HRA, Gross etc. components of a person’s salary. 
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Create salary rule 

 Pay Roll -> Salary Rule -> Create

 
Field Description 

Condition: - set a condition to apply the Rule 

Always True means the rule is always applied 

Range means you can choose a salary range to apply the rule 

By choosing Python expression you can configure more customization 

Computation: - Choose the computational scheme from the options 

Contribution Register: - Use, if third party involved in salary payment 

“Add more rules (if needed) from Child Rule tab and jump to Inputs and Description tabs to add 

other necessary details about Salary Rule” 

 Click Save to save the salary rule


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Update/Delete a salary rule 

 Pay Roll > Salary Rule
 

 

 Select the Pay Rule you wish to change from the list and  Click <Edit> button
 

 Make necessary changes in the fields and <save>

 Or you can delete the rule from Action > Delete
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Salary Structure 

Salary structure is the second building block in salary computation. A company may have 

different salary structure for different employees. In this section we can define different salary 

structure with the help of basic rules we already defined. 

Create Salary Structure 

 Payroll -> Configuration -> Salary Structure ->Create
 

You can add any applicable salary rule to this structure to make new salary rule. 

 Once finished click <Save>

 

Update/Delete Salary Structure 

 Payroll -> Configuration -> Salary Structure

 Select the salary Structure you wish to edit

 Click <Edit>

 

 

 Make the changes and <save>

 Or you can delete the structure altogether
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

Contribution Registers 

Contribution registers are used to manage the salary component contributed by external entities. 

You must create all contribution registers first, then it can be accessed while you create Salary 

Rule. 

 Payroll > Contribution Register > Create
 

Note: - “you can Update or Delete Contribution Register from the same menu itself” 

 

Payslip 

Pay slip is the ultimate output of Payroll. A pay slip undergoes different Status in Oddo Payroll 

management. ‘Draft’, ‘Waiting’, ‘Done’, ‘Rejected’.  These options are for the sake of proper 

management within the organization. A pay slip can be created by an entry level employee, but 

its approval must be come from a managerial employee. 

 
Create Pay slip 

 Payroll > Employee Pay slip > Create 
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Once you have filled the necessary information then click Compute Sheet to calculate salary and 

<Save> 

Note: - Once it is Confirmed, the Payslip will be in Waiting stage an officer level user must mark 

it as Done to get actual Approval for the Payslip. Same Rule stages are applicable to Batch 

Payslip also. 

 
Update or Delete Payslip 

Payroll > Employee Payslip

 Select any Payslip you wish to Update/Delete > Edit
 

 

 Make changes and Save

 Or Discard to delete the Payslip

 

Batch Payslip 

Batch Payslip is used to process Payslip for group of employees. You can add number of employee 

to a single batch and generate Payslip simultaneously instead of individual processing. 
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 Create Batch Payslip 

 Payroll -> Payslip Batches -> create



 Click Add an Item to add employees to list
 



 Add all the employees you need to the list and <Save>.
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Update/Delete Batch Payslip 

 Payroll -> Payslip Batches

 Select the Batch Slip from the list and click <Edit>
 

 Make changes and save

 Or you can discard



Expenses 

Expenses bared to an employee can be managed with simple steps in Odoo Expense manager. 

Here an employee can generate, submit and track status of his expenses. There are two ways to 

generate expense. Either by single expense or “Report Expense” mode. As the name indicates 

former can include only single expense at a time, later can add many items and expenses in a 

single report. 

Once the employee submits the expense details, concerned manager or officer can view it and 

take actions. An expense bill undergoes different states like “Submitted”, “Approved”, 

“Posted”, and “Paid”. These options are for sake of proper management of the expense bill 

within the organization just like in the case of Payslip. For example expense approval may be 

given by operation department and payment is done by the finance department. 
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Generate an Expense 

 

Single expense creation 

 Expenses > My Expenses > Expenses to Submit > Create
 

 Fill the fields and click <Submit to Manager>

 

“You can add more number of items to a same expense bill 
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“Once the expense is submitted you can see the status of the expense changes” 

 Finally save the Expense bill.

 

Note:-“Now it has to be approved by an officer level user.  Posted means the Payslip is posted 

in Journal and finally Paid status indicate the actual Payment. All these state changes can be 

done by different users. Same Rule is Applicable to Expense Report also.” 

Expense Report Creation (Multiple expense entry in a single bill) 
 

 Expenses > Expense Reports > Create

 Click <Add Item> to add single expenses to you bill.

 
 

 You can either choose an already created expense to your list or you can create 

new expense by clicking <Create> button

 <Save> the report and <Submit To Manager> for approval
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Approve / Pay / Reject Expense 

Expense approval is the duty of concerned department Head/Officer. 

Expenses > To Approve > Expense Report To Approve

 From the list select a submitted expense, scrutinize it and take appropriate action. 

 

Timesheet management 
 

Time sheets are closely associated with project management. In HR module Oddo gives the 

feature to prepare Timesheet for each employee. The important feature of Odoo timesheet is 

that, it can integrate with attendance of employee, thus gives an accurate working schedule. 

Create Timesheet 

 Timesheet -> My timesheet -> Create
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 Use dropdown list to select project and click <Add a Line> to add more projects 

 Go to Details tab to add more details about the timesheet 

 <Save> the timesheet and it will be automatically submitted to Manager for 

approval. 

 

Approve \ Reject Timesheet  

Decision on a submitted timesheet is taken by a managerial level officer. Login as Admin or a 

managerial level officer to view Timesheet management options 

 Timesheet -> To Approve -> Timesheets to approve

Select any Timesheet from the list to view Timesheet status. Here you can see attendance of the 

respective employee is integrated with time sheet for better decision making. 

 
 

 

Time sheet Report 

Concerned officer can view reports on Timesheet from following menu. Detailed analytical view 

is available in following menu 
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 Timesheet > Reports

 
 

Recruitment Management 

The Recruitment process is one of the major challenges for HR Department and Odoo provides 

Recruitment modules to make ease the process. From Odoo apps we can install plugins related 

with HR Recruitment. Here we can see three add-ons related with Recruitment process. 

 

 

Here, online jobs plugin installs website module and will create a new page on your website 

named Jobs. HR Recruitment Interview forms will installs survey module for interview forms. 

 

Create job Openings 

To create a job opening you must login as Admin or designated officer 

Recruitment -> Configuration -> Job Position -> Create 

Or 

Recruitment -> Job Position -> Create 
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 Fill the Job details and publish to Website

Now you can see the Job is listed on your Website under Jobs Tab 
 

 
 

Define Recruitment procedure 

Each company have its own recruitment process. You can define your own recruitment stages for 

recruitment. 
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Recruitment > Configuration > Stages > Create 
 

“Use Job Specific Dropdown option to restrict the stage to specific job positions” 

 

Create Recruitment Form 

To choose whichever Survey/questionnaire form to be filled by candidate while applying for job, 

Activate same option from Settings menu. 

 
 

Once you enable the option you can see an option in Job creation window to add Questionnaires 
 

 Use Add an Item to add fields to your form

 After completion <save>
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Apply for job 

Odoo provides a complete solution for recruitment process. Once you publish the created 

opportunities in website, jobseekers can view the same. User can view detailed advertisement 

and Apply by just clicking on the advertisement. 

 
 

 

By clicking on <Submit>. User submit his application. 

 

Process Job Application 

Recruitment administrator can view all the application and related personal information listed 

in his dashboard. 
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Recruitment > Job Position 

 
 

 Click <Application> View the applicants and their recruitment status.
 

 

 Just drag and drop to change the status of employees
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Odoo Point of sales 
 
The shopping and consumption characteristics of consumers are changing rapidly. Unlike in the 

past, the customers don’t have much time to spend in shops to find their desired product. 

Consequently, E-commerce sales are rising. Modernization and digitalization in every possible 

point will make shopping more interesting and hassle-free. ‘Point of Sale’ is an opportune place 

where you can utilize this digitalization technique to give an excellent customer experience. POS 

is the place at which a retail transaction is carried out. Generally, billing and final adjustments are 

made at this point. Odoo POS module combined with hardware components like the barcode 

scanner, POS box, etc. perform the sales procedure.  

Most of the present ERP systems provides Point of Sale option with varying configurations. Apart 

from speedy billing option, an excellent POS can facilitate functionalities like, discount and 

Loyalty programs support, multiple payment type support, serve multiple customers at a time 

and customer specific management, Accounting etc. To enable features like this, a POS system 

must be integrated with CRM, Inventory, Accounting and other necessary modules in the ERP. 

The detailed analysis report is another must-have feature in every POS system. Sales analysis on 

each POS is the key factor to take sales improvement decision.  

Odoo POS is an excellent ERP were you can find all these features by default. Moreover many 

add-ons and apps from Odoo app store further enhance the capabilities of Odoo POS like in every 

other module. The Simple and user-friendly interface of Odoo Point of sales module lets the user 

configure and complete his all sales needs with hassle-free steps. 

Some of the feature [15] which makes Odoo a well performing POS app are; 

 

 Payments 

Payment methods 

Cash, checks, and credit card payment methods are available. New types of payment 

methods can be added as well. 

Credit/Debit cards 

All electronic payments are handled by external payment terminals. 

Split tenders 

A single order can be paid as a split payment between multiple parties as well as with 

separate payment methods. 

Currency rounding 

Prices and payments can be rounded to the smallest denomination of the currency. 

Offline payments 

Orders made offline are automatically synchronized when you are reconnected. 

Invoicing 

Generate and print invoices for your business customers. 
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Accounting 

Payments are directly integrated into Odoo Accounting to make bookkeeping simple and 

reliable. 

Customer tips 

Supports customer tipping either as an added amount or by converting change to a tip. 
 

 Checkout 

Prices & discounts 

Set customer prices or offer percentage-based discounts on either a single product or 

the entire order. 

Parallel orders 

Put orders aside and process multiple orders at the same time. 

Customized receipts 

Advertise your current promotions, hours of operation, and upcoming events on your 

printed receipts. 

Weighting at the counter 

Calculate product weight during checkout with the electronic scale integration. 

Blazing fast search 

Quickly find your customers and products with the built-in search features. 

Sell on the move 

With iPad and Android tablet support, sell anywhere within your store or restaurant. 

Dynamic barcodes 

Embed price, weight, and discount information directly into your barcodes. 
 

 Store Management 

Order history 

View all past orders as well as search by customer, product, cashier, or date. 

Daily sales 

Keep track of daily sales and totals for every payment type. 

Cashier accounts 

Manage multiple cashier accounts and secure them with badges or pin codes. 

Cash flows 

Monitor cash register adjustments and easily verify cash contents at the end of the day. 

Stock & Inventory 

Monitor your stock in real-time, manage your inventory across all locations, and review 

shipments with the Odoo Stock integration. 

Franchises 

Pre-configure your franchises stores, overview their sales, and centrally manage their 

stock and accounting. 
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 Customer & Loyalty 

Register customers 

Identify your customers by simply registering their email and contact address, allowing 

you to offer discounts and keep track of individual sales. 

Identify customers 

Look-up your customers with the built-in search feature or identify them with a barcode 

printed on their loyalty card. 

Business Customers 

Register your customer's VAT number and apply them to invoices. 

Loyalty Cards 

Reward your customers with loyalty points and exchange them for gifts or discounts. 

Points can be earned by product, by order, or by sale amount. 
 

 Restaurant Management 

Floor plans 

Assign orders to tables and receive an overview of your restaurant's floors as well as 

make changes on the go with the graphical editor. 

Manage seating 

Keep track of your guests with an overview of your restaurant's capacity and table 

availability. 

Kitchen printing 

Send the order instructions to the bar and kitchen printers. Instructions can be sent to 

different printers automatically based on the product category. 

Delayed orders 

Take orders for different courses of the meal at once with the ability to send them to the 

kitchen printer at separate times. 

Kitchen order notes 

Add notes for customer's preferences, allergies, or special requests and send them to 

the kitchen or bar printers. 

Split bills 

Let customers pay separately or at different times by splitting orders. 
 

 Products 

Product categories 

Organize your products with hierarchical product categories. Order them by popularity 

and display different categories in different point of sales. 

Product Search 

Quickly find products by their name, barcode, or description with the built-in search 

function.  
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Units of measure 

Sell your products with custom or preset units of measure and update your stock 

accordingly. 

Multiple barcodes 

Configure multiple barcodes for the same product with barcode nomenclatures. 

Product variants 

Sell different sizes, colors, or configurations of the same product with product variants. 

Large product count 

Odoo's Point of Sale system is capable of performing at a scale of over 100,000 products. 

 

 Web Application 

Browser support 

Odoo POS is a web-based application and can be deployed on any device and OS running 

Chrome, Firefox, or Safari. Microsoft Windows, Apple OSX, Linux, Android, and iOS are 

all supported operating systems. 

PC compatible 

Odoo POS can also be used on standard PCs and tablets as well as industrial touch-screen 

terminals. 

Works offline 

Odoo's POS will keep working while offline. The web browser can be closed offline 

without loss of data. 

HTML5 mods 

Odoo's POS is Open-Source and can be customized with HTML5/JS extension modules 

[15] 

 

By default, there are two types of user in Odoo POS module. Admin can create and assign this 

role to any of his employees. 

 

 Manager 

He has complete control over all the POS nodes. He configures, monitor and manage it. 

He creates a POS and assigns it to any user. He can also Add and Update product 

information. 

 

 User:-  

This user will have access to only those POS assigned to him. He can log in to his POS and 

start the session. 
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How Odoo POS works 

 

Manager creates and configures each POS nodes in Odoo POS. The system administrator can 

assign this POS node to appropriate users from ‘Point of Sale’ tab in the user profile. When a POS 

user login to the system, he will be directed to his POS dashboard. From there he can perform 

sales operations. A user must start a new session or resume an existing session to perform sales 

operations. Moreover, a user cannot use two Point Of Sale sessions simultaneously. The 

important point to note in Odoo POS is that the Point Of Sale session must be closed and 

validated in order to generate all the accounting entries. When a salesperson close and validate 

his session the respective entries will be passed to accounting module, from here, the authorized 

person can commit the transactions made. 

Some other distinctive feature of Odoo POS is listed below. 

 

Basic Configuration 
 
Setting up new payment method 

To add new payment method to your POS system follow the steps. 

 Click <Payment Methods>option under Configuration tab, and click on <Create> button, 

which will guide you to the following window
 

Click <Advanced Settings>, <Point of sale> tabs to find more customizable options. 
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Creating new product category 

Your product list can be customized/categorized according to you needs. To create a new 

product category follow the below procedures 

 

 Click <POS Product Categories> option under Configuration tab, and click on 

<Create>button, which will guide you to the following window
 

 Fill all the fields and <save> new category.

Note: - “you can delete or edit any particular category from the same menu.” 

 
Creating new Point of Sale 

You can create any number of point of sales. When you create a user you can see an option to 

assign a POS to the user. 

 Click <Point of Sale> option under Configuration tab, and click on <Create>, button, 

which will guide you to the following window
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• Fill all the necessary fields including Journal, payment methods for POS etc. and click 

<Save>. 

 

Adding new products to list 

To Add new products to your list follow the below procedures 

 Click <Product> option under <Orders> tab, and click on <Create>, button, which will 

guide you to the following window

 
 

Fill the fields with product specification. Toggle between General Info, Inventory, Sales, and 

Invoice tabs to find more options and settings for the product and <save>. 

Note: - “you can edit details of any particular product from the same menu (i.e. <Product> option 

under <Orders> tab) by clicking the image of respective product” 
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Other miscellaneous configurations. 

You can find some useful and important settings like activating card payment, 

activating restaurant mode, etc. in <settings> menu under <Configuration> Tab 

 

POS Restaurant mode configuration 

 Find Activate table management option from <settings> menu under <Configuration> 

tab.

 

 
Floor and Table planning in Restaurant 

Customize the floor and seating arrangement in you restaurant (this option will be available only 

after activating Restaurant configuration as in sec. 2.1) 

 Click <Floor Plans> option under Configuration tab, and click on <Create>, button, 

which will guide you to the following window
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 Click <Add an Item> to add Tables and manage seating arrangements on that floor.



Note: - “you can edit details of any particular Table/Floor from the same menu (i.e. 

<Floor Plans> option under <Configuration tab>). 
 

Add new Printer 

Attach new printer to your POS (this facility is available only after you have activated 

restaurant mode). 

 Click <Product> option under Orders tab, and click on <Create> button, which will 

guide you to the following window
 

Fill the fields with printer info and <save>. 
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Sales management 
Making an Order 

 Once the user you login to POS, the main dashboard will be like below. <Create> a 

new Session or <resume >an existing Session to make an order
 

 

 

 Click on the product to add to Cart (the amount will be updated automatically)

 Use <QTY> button to enter no of quantities

 Use <Price> button to enter price manually

 Use <Disc> button to allow discount

 Click on <Payment> button to proceed to payment.
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

 Choose the payment method from list.

 Click <Validate> to generate 

invoice. Or you can

 Click on <Customer> to select a customer from your system

 Use <Invoice> option to generate invoice against the customer.

 Once the validate button is clicked system generate invoice.
 

Making an Order (Restaurant Configuration) 

 Select the Table/Floor from the list

 Click on the product to add to Cart (the amount will be updated automatically)
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 Use <Split> option to split bill

 Use <Transfer> option transfer the table

 If completed, proceed to <Payment> option

 You can choose <Customer> option to generate bill against an existing customer

 

Print the receipt and Click <Next Order> to make another order. Click <Close> button to close 

the session. 

 

Reports Generation 

 Select <Order> option under <Reports> tab to generate Order report.

 Select <Sales> option under reports tab to generate sales details of a particular time period.
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Odoo Website Builder 

With the help of Odoo website builder you can to develop stunning websites without much 

effort. This feature enables any normal user to develop his own company’s online presence. The 

website serves multiple purposes for your company. On the one hand it publishes information 

about your company and on the other hand, it can act as E-commerce site (See E-commerce 

module), HR Recruitment Portal (See HR module), and Customer portal (See Project 

management). You can explore these features from those modules. Here we will be discussing 

basic website builder functionalities. Following are some features [16] of Odoo Website builder. 

 

 Intuitive system 

What you see is what you get 

Insert text styles like headers, bold, italic, lists and fonts with a simple WYSIWYG editor. 

Flexible and easy to use. 

Building blocks system 

Create your page from scratch by dragging and dropping pre-made, fully customizable 

building blocks. 

Front end management 

Click and change content directly from the front end: no complex back end to deal with. 

Word processor text editing 

Create and update your text content through an editor designed to replicate the word 

processor experience. 
 

 Increase visits 

Promote Tool 

Improve your ranking on search engines and your organic traffic thanks to keywords 

suggestions and Meta tag tool. 
 

 Convert leads 

A/B test your pages 

Run several versions of one page to find out which one drives better results. Analyze 

results directly on Google Analytics. 

Multi-version 

Prepare multiple versions of your website and switch from one to another in one click.   

Link tracking 

Add a tracking code to your URL's and measure all your marketing campaigns from the 

first click to the final sale. Identify which campaigns are the most effective in attracting 

visitors to your website and generating revenue. 
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 Enhance user experience 

Translation tool 

Get professional standard translations with Gengo integration. 

Mobile preview 

See what your page will look like on a mobile device with the mobile preview button. 

Social media call-to-action 

Share your pages through social media networks. 

Live chat embedded 

Provide your visitors with information in real time directly on your website through a 

popup chat window. 

 

 Design features 

Bootstrap based templates 

Easily design your own Odoo templates thanks to clean HTML structure and bootstrap 

CSS. 

Fluid grid layout 

Create the best layout corresponding to the devices on which the website is displayed. 

Professional themes 

Change theme in just a click, and browse through Odoo's catalog of ready-to-use 

themes available in our app store. [16] 

 

System Users 

By default, there are two types of user in Website related modules. 

 

 Editor and Designer: 

Like manager in other modules, he can access both frontend and backend of your 

Website. He configures your website and changes its settings like setting up payment 

gateway, giving portal access to customers etc. 

 Restricted Editor:- 

Basically front end (i.e. portal) designer. Generally, he can alter only the portal view of the 

site. 
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Add your first Page 

 Login as administrator

 Click <New> button on top right corner,

 Enter page name and click <Continue>

 

It will give you a default page and tools to design the page just Drag and Drop the contents 

Click on any element to customize it

 Use the different design tools to make your website more attractive

 
Don’t forget to save the current design once you finished 

 

 To get mobile view of the website you can click, mobile preview button which is in the top left

Side of menu bar. 

 Once you save the page, the page will be displayed on ‘Menu bar’
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Customize menu and appearance 
 

Menu and page customization 

You can change the appearance of your website including Menu, and product view easily. To 

customize menu follow 
 

 Website > Content > Edit Menu
 

 

This window will assist you to create new menu options, create submenu and delete menu 

options. 

 
Appearance customization 
 

To change the appearance of the  website like the way your products are listed etc. follow 

Website > Customize 

 
 

Choose from many of the useful options available to make your website more user-friendly 
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List your products on site 

 Website > New > New product
 

 Fill the name, image and cost and click <Save>

SEO Integration 
 

Odoo SEO tools combine with Google to check the relevancy of your content in real time. Get 

more visitors with a better-targeted content. Admin can access this facility from 
 

 Website Admin > Settings

 

Here you can see the options to track and manage performance of your Website. And you can 

access some other settings from 
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 Website > Promote > Optimize SEO

  

179



 

 

E-commerce 

This feature make Odoo more powerful than any other competitor. Odoo E commerce App 

supports you to sell your products online. You can design your own site with simple steps. Add 

products, configure payment and delivery methods and let public to access your site, all in 

simple steps. Since it is integrated with other modules like CRM, Sales, and Inventory Odoo can 

provide and effective platform for your business. You just have to install the eCommerce 

application from Odoo apps store. To further enhance the system capabilities you may install 

eCommerce delivery, and eCommerce optional products. 

Odoo E-commerce module displays competitive features when compared to CMS service 

providers like Magento and Shoppify. The most promising thing is that many add-on features in 

other CMS service providers are built in components in Odoo. Odoo enjoys the advantage of 

features like Product Inline Page Builder, Drag and Drop Page Builder, Buy Without Sign Up, 

Inline SEO Suggestion, Link tracker etc. over Magento. And over shoppify, Odoo has the 

advantage of options like Stock Available, Drag and Drop Page Builder, Integrated A/B testing, 

Inline SEO Suggestion, Multi Store Support, Advanced Taxes etc.[17] 

 Some of the useful features [18] of Odoo are below.  

 

 Design & configure 

Inline Editing 

Create product pages using Odoo's unique 'edit inline' approach. No code required, 

what you see is really what you get. 

Building blocks system 

Create your product page from scratch by dragging and dropping pre-made, fully 

customizable building blocks. Describe products in a table to give maximum of 

specifications. 

Sell digital products 

You can now add digital products like eBooks to your online catalog. 

Word processor text editing 

Easily create and update your text content through an editor designed to replicate the 

word processor experience. 

Product variants creation 

Create a product available in several variants, like size, colors or other attributes. 

Price-lists, products and stores 

Create flexible price-lists, add variants to add to products options, and create multiple 

stores under one environment. Display available stock on products. 
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 Integrated tools 

Cross-selling and Upselling 

Suggest optional products related to items to increase your revenues. 

Promotional or coupon codes 

Encourage potential customers using promo codes and coupons. 

Options to boost sales 

Define product categories, use attribute search, focus on promotions, coupons or gift 

certificates and push best products to the top of your page in order to multiply your 

sales. 

 Shopping experience 

Easy search system 

Make finding products easier by setting attributes on products (size, color, power, etc.). 

Customer on boarding 

Setup step by step instructions to help customers go to checkout with no blocking 

issues. 

Guest & registered user 

Customers can choose to create a user profile or as guests. Registered users can retrieve 

their contact information upon check out and access a portal including related 

messages, orders, invoices, registered claims, etc. 

Skip shipping address 

Shipping address no more required when providing only services. 

Live chat embedded 

Provide your visitors with information in real time directly on your website, and secure 

your sales. 

Easy checkout process 

Simple checkout to avoid losing clients. 

Customer portal 

Access tracking of orders, advanced shipping rules and return management through the 

customer portal. 

Order review 

See details of your order at the end of the process. 

 Payment methods 

Fully integrated 

Allow customers to pay with Paypal, Ogone, Adyen, Buckaroo, Authorize.net and SIPS 

Wordline. Online payment methods redirect customers to a 'Thank you' page on your 

website. 
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 Billing & Accounting 

Calculate & Bill Shipping Costs 

Get delivery costs computed automatically using Odoo's embed Delivery Method 

configurator. 

Integrated Accounting package 

Odoo’s chart of accounts contains national taxes, fiscal positions, accounts. 

Tax rates 

Fiscal positions allow you to adapt tax rates to the whereabouts of your customers. 

Chart of accounts 

Use the Custom package template to build your own chart of accounts. It embeds a set 

of generic preset accounts, taxes and more. 

 Reporting 

Sales data analytics 

Highlight the best product in terms of quantity sold. Find the best customer in terms of 

revenue. Display a graph with your monthly sales per product and add it to your 

Dashboard. Group your Sales by Partner and display the products in the column header. 

[17] 
 

System Users 

By default there are two types of user in Website related modules. 

 Editor and Designer: Like manager in other modules he can access both front end and back 

end of your website. He configure your website and change its settings 

 Restricted Editor: - Basically front end (i.e. portal) designer. Generally he can alter only the 

portal view of the site and products with some restriction etc. 
 

Product Management 
 

Add new Product 
 
Website Admin > Products > Create 
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Fill all necessary fields by switching to ‘inventory’, ‘sales’, ‘variants’, ‘invoicing’, tabs and <save> 

the product. It will be added to your website 

 
Edit Product Details 

You can Update/Edit a product details buy just clicking on the product image from 

 Website Admin > Products

 

 Click <Edit> button to edit product info

 <Update Quantity in Hand> to update quantity manually
 

Add new Product Category 

To add new product category go to 

Website Admin > Configuration > Website Product category > Create 
 

 

Choose the parent category (if applicable) and save 

Edit Product Category 
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Delete or Edit a product category 

Website Admin > Configuration > Website Product category 

 Click on any of the listed category to update or delete it

 

 

Order Tracking 
 

View Order 

To view orders received to you web site 

Website Admin > Orders > Order 
 

 

Note: - There is an option to create order manually if needed. 
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View Unpaid Order 

 Website Admin > Orders > Unpaid Order 

 

Website Settings 

If we navigate to website admin > Configuration > Settings, then we can see more option that 

we can enable in our website, now let us look into it.

E.g .:- Multiple image enabled product. (Settings 1) 
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(Adding multiple images) 

 
 

User view of a multiple image enabled product 

Like ways administrator change the settings to improve user experience from the above panel 
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Set up delivery options 
 

Inventory > Configuration > Delivery > Delivery Methods.
(To view this option you must activate delivery methods are selectable on the web site option 

from settings) 
 

 

Fixed Price and Based on Rules two option available to set up payment option. Using Based on 

Rules option you can customize delivery method. 
 
 

 

Note:- the very important things is that you must click ‘Published on Website’ button before 

you quit the wizard to make the new delivery option available to users 
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Configure Payment methods 

 Website Admin > Configuration > E-commerce-> Payment Acquires

We can install the required payment methods from here 

 

 Click <Configure>
 

 

Once you configured the settings, Publish the same on Web site to make it available for users 
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Project Management 
 

Project Management is a collection of guiding processes to achieve a specified target.  That may 

include initiation, planning, assignation, controlling, analysis and closing. Project management 

app is one of the powerful tools in Odoo. Where we can run any type of projects with user-

defined workflow. To enable project management functionalities in Odoo, you first need to 

install Odoo Project App.  

 

With Odoo project management module you can define your project, add tasks in it, assign tasks 

to employees, manage employee timesheet and track issues associated with the project 

effectively. The module also provides an option to enable portal view, through which your client 

can track the progress of the project. Just like in all other modules, the reports generated by BI 

engine gives an insight to all your projects. 

 

Some of the features [19] of the Odoo project management module is  

 Clean and fast 

Modern User Interface 

A fast user interface designed for modern project management. Get all the information 

you need where you need it. 

Mobile 

Mobile-friendly. Track projects and tasks easily on the move. Stay connected, always. 

Filters and Groups 

Search tasks or issues easily with the smart filters. Analyze data with multi-level 

grouping. 

Fully customizable 

Customize the process of every project, rename stages and alerts according to your own 

activities, automate emails, etc. 

 Tasks 

Customized Kanban View 

Drag & drop tasks easily with the ‘Kanban’ view. Group tasks by stages, responsible, 

deadline, etc. Change name of “task/issues”. Change the meaning of the green/red 

status. Create specific stages per project. Define the process through custom tool-tips 

for each stage. Create tasks from sales orders. 

Calendar of Deadlines 

Use the calendar view on tasks to highlight project deadlines. Simply drag & drop tasks 

in the calendar to reschedule. 
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Multi-projects 

Work on single or multiple projects at the same time. Perform multi-project analysis 

and searches. 

Document Management 

Manage documents related to tasks, issues or projects. (Specifications, plans, etc.) 

Gantt Chart 

Manage tasks on a timeline with the Gantt chart view. The easiest way to track 

deadlines and timeline progress. 

Graphs 

Get graph charts to analyze the progress of your tasks: by stage, by responsible, by tag, 

by project, etc. 

Pivot Table Analysis 

Use the pivot table on tasks to perform deep statistical analysis on the performance of 

your projects. 

Time Tracking 

Track expected hours, effective hours, and re-forecasts on tasks. 

Archive tasks 

Archive tasks done and have a clear view of the other tasks you still need to work on. 

 Issues 

Customer tickets 

Use issues to track support contracts, tickets, bug reports. 

Email integration 

Communicate with your customers by email. Everything is automatically attached to 

the issue to get a full visibility. 

Service Level 

Link SLA-related information to issues: time to open a ticket, time to close a ticket, 

statistics on the volumes and performances, etc. 

Automate actions 

Use triggers and automated actions to send automatic emails on different statuses: 

confirmation of ticket, customer satisfaction survey, etc. 

 Customer Services 

Timesheets 

Track time on projects and tasks using the timesheet app. Available as a Chrome plugin 

or a mobile app. 

Customer Satisfaction 

Use the customer satisfaction rating survey to get feedback from customers every time 

you close an issue. Configure the automatic email sent to customers after each 
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milestone and receive their feedback directly. Analyze overall rating by project to 

improve your process. 

Forecasts 

Forecasts projects and resources easily from the Gantt chart taking employee holidays 

into account. Compare forecasts with real timesheets. 

Portal front-end 

Customers have access to their tickets from the portal. 

 Multi-Purpose 

Internal Projects 

Track internal projects with tasks and manage teams efficiently by setting clear 

priorities. 

After Sales Services 

Effortlessly manage after sales services requests and configure a customized process in 

the Kanban view. 

Support Contracts 

Automatically create issues by email, track support services and count hours on 

contracts. 

Customer projects 

Forecast project resources, track tasks and milestones, record timesheet and analyze 

the performance of the team. [19] 

 

System Users:- 

There are two type of users in Project Management 

 Project Manager: - Who can create and manage projects.

 Project User: - Who can access the tasks assigned to him

 

 

Basic Management 
 

Create Project 

Either you can use the Create button in Dashboard or 
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 Project -> Configuration -> Projects -> Create

 

 

Task as field will allow you to give a custom name for your project Tasks

 Set Project Manager, and other privacy settings for your projects.

 Save and mark Active to make the project Available

“Now you can see the project is listed in your dashboard” 

Note: - You can Update/Delete any project from the same menu i.e. Project > Configuration > 

Projects 

 
Create Task 
 

By creating a Project you have just created the template.  Now it is the time to create tasks   in 

your Project. You can create a Task by two methods. 

Method 1: 
 

 Project > Dashboard
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 Click the project you wish to add Task.
 

Listed are the different Stages of a Project. 

 You can add a Task at any stage by Just clicking on the ‘+’ button

 To view Update/Delete option click on the task

  Or you can follow 

 Project > Task > Create
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 Choose the Project

 Assign the Task to user

 Once you choose the project you can add Timesheet for this task

 Mark <Active> and <Save>

 

Note: - You can Update / Delete any task information from the same menu i.e. Project > Task > 

 
Define Project Stages 
 

You can define different stages for your Project. To customize the stages 

 Configuration -> Stages -> Create
 

 Fill the fields and Save

Note: - you can Update/Delete any stage from the same menu i.e. Configuration > Stages  

 
Timesheet management 
 

Timesheet management is a very important aspect in Project management. After project 

manager creates a project and assigns its task to different user, all such users can access project 

Timesheet and add their contribution to it. The same operation can be done through Timesheet 

Management Module of Odoo. To enable this feature you must install Timesheet App from 

Odoo. 
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To add a timesheet 

 Select the project from Dashboard



 
 

 Select the task you wish to add a Timesheet

 In Task details, under Timesheet menu click Add an Item
 

 After passing entry Save the Task
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Note: - This entry will be automatically updated to employee’s Personal timesheet, which he can 

view from Timesheet -> My Timesheet 

 

Note: - “whenever a user Passes an entry in timesheet, the total time assigned to that task 

automatically reduces” 
 

 
 

 

 

Issue Tracking 
 

In project management, Issues and its tracking is a very important thing. We can enable this 

feature in Odoo by installing “Issue Tracking” from apps. 

This Issue Tracking module manages issues we might face in a project like bugs and errors in    a 

system, client complaints or material breakdowns etc. So it allows the project manager to 

deploy any person to work over the reported issues. Issues should have some workflow. It will 

take the project's workflow automatically if we mention any project in issue form. We can go 

through its fields 
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Create an Issue 

 Project >Search > Issue > Create

 

 

 You can assign the issue to an employee to solve

 You may also set priority

 Fill the fields and Save

Note: - You can track and Update an issue progress from same menu i.e. Project ->Search -> Issue 
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Report 
 

Different Kind of Reports related to a Project as well as Issues are available under Reports tab. 
 

 

Project Customer Portal: 
 

The Customer can analyze his project related tasks, timesheets, issues and their status through 

customer portal in your website. For this, we have to set the project privacy as “Visible by 

following customers” in project settings. We have to install “Website Project” and “Timesheet 

in Website Portal” apps from Odoo to access this features. By giving your customer the portal 

access, he can view the progress of his project as well as can interact with your organization. 

 

Portal Access Management: 
 
To give a customer Portal access either you can create a user with Portal access by the 

Following procedure. 
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 Configuration > Project > Select the Project 

 Click on the customer


Actions > Portal Access Management



 Click on the email of the user (to whom we want to give access)

 Tick Portal access

 

An invitation mail will send automatically to the customer with Username and Password to his 

portal. He can login to your site and see the entire project in the website. 
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 Customer can message to project management team through his portal, and such 

messages will be Appended Project details
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Know some of our Apps and Plugin 
 

Cybrosys  has  made  an immense contribution  to Odoo development community  by providing online 

community  assistance  through  forums   and  community  portals.  But our greatest contribution is the 

150+ free applications and Plugins we made available in the Odoo App store. We have made custom 

applications for almost all the modules.  You can access these useful plugins   from Odoo app store for 

free. 

A snapshot of Cybrosys Apps 
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Odoo Apps by Cybrosys 

 
A few of the Odoo Apps from Cybrosys. View more from Odoo App store 

 

Product Stock Excel Report 
 

 

This Plugin helps you to export current stock report of all products to XL datasheet. 

 

 

Sub Task 
 

Normally in Odoo Project Management module you can add Tasks under a particular project 

but no sub tasks. This plugin enable following features. 

 Sub-Task Lists under Task. 

 Sub-Task Count in Task Kanban View. 

 Sub-Task Stages in Configuration. 

 Sub-Task Analysis under Report. 

 Deadline Validation for Sub-Task. 

 Stage Validation for Sub-Task 
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Discount in Sales 
 

This module allows you to mention discount on Total of sale order and Total of 

Customer Invoice in two ways 

1. As percentage 

2. As Amount 

 
Vehicle Workshop 
 

 
Car Workshop Management is an efficient app from Cybrosys to manage automobile workshop 

with great ease. Keep track of everything, like vehicle owner details, Works assigned, Bill details, 

etc. with this plugin 

Some other features are as below: 

 User Friendly Interface.

 Effective Time management.

 Separate Journal Configuration..

 Integrated with Accounting.

 High Scalability.
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Fleet Rental Management 
 

This App facilitate vehicle rental management features in Odoo. 

Features 

 Multiple Plans for Rental Contract (Days/Weeks/Months/Years).

 Integrated with Accounting Module.

 Automatically Create Recurring Invoices.

 Sending email for confirmation, first payment and recurring invoices.

 Check List Facility.

 Separate Tree view for Checklist.

 Damage Checking Facility.

 Billing Facility for Damages/Check Lists.

 Contract Payment Validations.

 Detailed Fleet Rental Analysis Report.

 Access Rights from Multiple Level.

 

Account Payment Receipt 
 

With this plugin you can generate and print Receipts for your customers and vendors. 
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Beauty Spa Management 
 

 Main features

 Online Booking Facility

 Accounting Facility

 Customer Notification through Mail

 User Interactive Dashboard

 Customer can view the Available chairs and order details

 Different access levels for Users and Administrator

 Track the chair user by date

 

 

 

Life Line for Task 
 

You can create Life Line Bar for the task with this Plugin. 

 User Defined Progress Bar Color Configuration.

 Task Lifeline Bar based on Deadline.

 Automatic Color Change of Lifeline Bar.

 Default Color for Forbidden.
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Reminders 
 

Reminders helps you to attach important dates and Tasks to any of your module. 

 

 
Automatic Developer Mode 
 

This module makes you free from activating developer mode operations repeatedly. When you 

login, it will trigger the DEVELOPER MODE automatically. 

 Automatically Trigger Developer Mode.

 Showing Running DB on Left Top.

 Update modules easily
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